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Abstract

KStars is a graphical desktop planetarium for KDE. It depicts an accurate sim-
ulation of the night sky, including stars, constellations, star clusters, nebulae,
galaxies, all planets, the Sun, the Moon, comets and asteroids. You can see the
sky as it appears from any location on Earth, on any date. The user interface
is highly intuitive and flexible; the display can be panned and zoomed with
the mouse, and you can easily identify objects, and track their motion across
the sky. KStars includes many powerful features, yet the interface is clean and
simple, and fun to use.
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Chapter 1

Introduction

KStars lets you explore the night sky from the comfort of your computer chair.
It provides an accurate graphical representation of the night sky for any date,
from any location on Earth. The display includes 126,000 stars to 9th magni-
tude (well below the naked-eye limit), 13,000 deep-sky objects (Messier, NGC,
and IC catalogs), all planets, the Sun and Moon, hundreds of comets and as-
teroids, the Milky Way, 88 constellations, and guide lines such as the celestial
equator, the horizon and the ecliptic.

However, KStars is more than a simple night-sky simulator. The display pro-
vides a compelling interface to a number of tools with which you can learn
more about astronomy and the night sky. There is a context-sensitive popup
menu attached to each displayed object, which displays object-specific infor-
mation and actions. Hundreds of objects provide links in their popup menus
to informative web pages and beautiful images taken by the Hubble Space Tele-
scope and other observatories.

From an object’s popup menu, you can open its Detailed Information Window,
where you can examine positional data about the object, and query a huge trea-
sury of online databases for professional-grade astronomical data and litera-
ture references about the object. You can even attach your own internet links,
images and text notes, making KStars a graphical front-end to your observing
logs and your personal astronomical notebook.

Our Astrocalculator tool provides direct access to many of the algorithms the
program uses behind the scenes, including coordinate converters and time cal-
culators. The AAVSO Lightcurve Generator tool will download a lightcurve
for any of the 6000+ variable stars monitored by the American Association of
Variable Star Observers (AAVSO). The lightcurves are generated ‘on the fly’
by querying the AAVSO server directly, ensuring that you have the very latest
data points.

You can plan an observing session using our Altitude vs. Time tool, which will
plot curves representing the Altitude as a function of time for any group of
objects. If that is too much detail, we also provide a What’s Up Tonight? tool
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that summarizes the objects that you will be able to see from your location on
any given night. You can add your favorite objects to the Observing List tool,
which provides convenient access to common actions for a list of objects.

KStars also provides a Solar System Viewer, which shows the current configu-
ration of the major planets in our solar system. There is also a Jupiter Moons
Tool which shows the positions of Jupiter’s four largest moons as a function of
time.
Our primary goal is to make KStars an interactive educational tool for learning
about astronomy and the night sky. To this end, the KStars Handbook includes
the AstroInfo Project, a series of short, hyperlinked articles on astronomical
topics that can be explored with KStars. In addition, KStars includes DBUS
functions that allow you to write complex scripts, making KStars a powerful
"demo engine" for classroom use or general illustration of astronomical topics.

However, KStars is not just for students. You can control telescopes and cam-
eras with KStars, using the elegant and powerful INDI protocol. KStars sup-
ports several popular telescopes including Meade’s LX200 family and Cele-
stron GPS. Several popular CCD cameras, webcams, and computerized fo-
cusers are also supported. Simple slew/track commands are integrated di-
rectly into the main window’s popup menu, and the INDI Control Panel pro-
vides full access to all of your telescope’s functions. INDI’s Client/Server ar-
chitecture allows for seamless control of any number of local or remote tele-
scopes using a single KStars session.

We are very interested in your feedback; please report bugs or feature requests
to the KStars development mailing list: kstars-devel@kde.org. You can also use
the automated bug reporting tool, accessible from the Help menu.

2
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Chapter 2

A Quick Tour of KStars

This chapter presents a guided tour of KStars, introducing many of its impor-
tant features.

The above screenshot shows a typical view of the KStars program. You can see
the sky display centered on Betelgeuse, the brightest star in the constellation
Orion. Orion has just risen above the eastern horizon. Stars are displayed with
realistic colors and relative brightnesses. In three corners of the sky display,
there are on-screen text labels displaying data on the current time (‘LT: 16:38:42
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23 Jan 2008’), the current Geographic Location (‘Tucson, Arizona, USA’), and
the current object in the center of the display (‘Focused on: Betelgeuse (alpha
Orionis)’). Above the sky display, there are two toolbars. The main toolbar
contains shortcuts for menu functions, as well as a time-step widget which
controls how fast the simulation clock runs. The view toolbar contains buttons
that toggle the display of different kinds of objects in the sky. At the bottom
of the window, there is a status bar which displays the name of any object
you click on, and the sky coordinates (both Right Ascension/Declination and
Azimuth/Altitude) of the mouse cursor.

2.1 The Setup Wizard

The first time you run KStars, you will be presented with a Setup Wizard,
which allows you to easily set your geographic location and download some
extra data files. You can press the Finish button at any time to exit the Setup
Wizard.
The first page of the Setup Wizard allows you to choose the starting geographic
location, by selecting from the list of the 2500+ known locations on the right
side of the window. The list of locations can be filtered to match the text you
enter in the City, Province, and Country edit boxes. If your desired location is
not present in the list, you can select a nearby city instead for now. Later on,
you can add your precise location manually using the Set Geographic Location
tool. Once you have selected a starting location, press the Next button.

The second page of the Setup Wizard allows you to download extra data that
are not included with the standard distribution of KStars. Simply press the
Download Extra Data button to open the Get New Stuff tool. When you are all
done, press the Finish button in the Setup Wizard to start exploring KStars.

2.2 Have a Look Around

Now that we have the time and location set, let us have a look around. You can
pan the display using the arrow keys. If you hold down the Shift key before
panning, the scrolling speed is increased. The display can also be panned by
clicking and dragging with the mouse. Note that while the display is scrolling,
not all objects are displayed. This is done to cut down on the CPU load of
recomputing object positions, which makes the scrolling smoother (you can
configure what gets hidden while scrolling in the Configure KStars window).
There are several ways to change the magnification (or Zoom level) of the dis-
play:

1. Use the + and - keys

2. Press the Zoom In/Zoom Out buttons in the toolbar

3. Select Zoom In/Zoom Out from the View menu
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4. Select Zoom to Angular Size... from the View menu. This allows you to
specify the the field-of-view angle for the display, in degrees.

5. Use the scroll wheel on your mouse

6. Drag the mouse up and down with the middle mouse button pressed.

7. Hold down Ctrl while dragging the mouse. This will allow you to define
a rectangle in the map. When you release the mouse button, the display
will zoom to match the rectangle.

Notice that as you zoom in, you can see fainter stars than at lower zoom set-
tings.

Zoom out until you can see a green curve; this represents your local hori-
zon. If you have not adjusted the default KStars configuration, the display
will be solid green below the horizon, representing the solid ground of the
Earth. There is also a white curve, which represents the celestial equator, and
a brown curve, which represents the Ecliptic, the path that the Sun appears
to follow across the sky over the course of a year. The Sun is always found
somewhere along the Ecliptic, and the planets are never far from it.

2.3 Objects in the Sky

KStars displays thousands of celestial objects: stars, planets, comets, asteroids,
clusters, nebulae and galaxies. You can interact with displayed objects to per-
form actions on them or obtain more information about them. Clicking on an
object will identify it in the status bar, and simply hovering the mouse cursor
on an object will label it temporarily in the map. Double-clicking will recenter
the display on the object and begin tracking it (so that it will remain centered
as time passes). Right clicking an object opens the object’s popup menu, which
provides more options.

2.3.1 The Popup Menu

Here is an example of the right click popup menu, for the Orion Nebula:
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The appearance of the popup menu depends somewhat on the kind of object
you right-click on, but the basic structure is listed below. You can get more
detailed information about the popup menu.

The top section contains some lines of information which are not selectable:
the object’s names ("M 42"; "Orion Nebula"), object type ("gaseous nebula"),
and the constellation which contains the object ("Ori"). The next three lines
show the object’s rise, set, and transit times. If the rise and set times say "cir-
cumpolar", it means that the object is always above the horizon for the present
location.
The middle section contains actions which can be performed on the selected
object, such as Center and Track, Details..., and Attach Label. See the popup
menu description for a full list and description of each action.

The bottom section contains links to images and/or informative webpages
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about the selected object. If you know of an additional URL with informa-
tion or an image of the object, you can add a custom link to the object’s popup
menu using the Add Link... item.

2.3.2 Finding Objects

You can search for named objects using the Find Object tool, which can be
opened by clicking on the search icon in the toolbar, by selecting Find Object...
from the Pointing menu, or by pressing Ctrl+F. The Find Object window is
shown below:
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The window contains a list of all the named objects that KStars is aware of.
Many of the objects only have a numeric catalog name (for example, NGC
3077), but some objects have a common name as well (for example, Whirlpool
Galaxy). You can filter the list by name and by object type. To filter by name,
enter a string in the edit box at the top of the window; the list will then only
contain names which start with that string. To filter by type, select a type from
the combo box at the bottom of the window.
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To center the display on an object, highlight the desired object in the list, and
press Ok. Note that if the object is below the horizon, the program will warn
you that you may not see anything except the ground (you can make the ground
invisible in the Display Options window, or by pressing the Ground button in
the View toolbar).

2.3.3 Centering and Tracking

KStars will automatically begin tracking on an object whenever one is centered
in the display, either by using the Find Object window, by double-clicking on
it, or by selecting Center and Track from its right-click popup menu. You can
disengage tracking by panning the display, pressing the Lock icon in the Main
toolbar, or selecting Track Object from the Pointing menu.

NOTE
When tracking on a Solar System body, KStars will automatically attach an ‘orbit
trail’, showing the path of the body across the sky. You will likely need to change
the clock’s timestep to a large value (such as ‘1 day’) to see the trail.

2.3.4 Keyboard Actions

When you click on an object in the map, it becomes the selected object, and its
name is identified in the statusbar. There are a number of quick key commands
available which act on the selected object:

C Center and Track on the selected object

D Show the Details window for the selected object

L Toggle a visible name label on the selected object

O Add the selected object to the Observing List

T Toggle a visible curve on the sky, showing the path of the object across the
sky (only applicable to Solar System bodies)

NOTE
By holding down the Alt key, you can perform these actions on the centered object,
rather than the selected object.
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2.4 End of the Tour

This concludes the tour of KStars, although we have only scratched the surface
of the available features. KStars includes many useful astronomy tools, it can
directly control your telescope, and it offers a wide variety of configuration
and customization options. In addition, this Handbook includes the AstroInfo
Project, a series of short, interlinked articles explaining some of the celestial
and astrophysical concepts behind KStars.
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Chapter 3

Configuring KStars

3.1 Setting the Geographic Location

Here is a screenshot of the Set Geographic Location window:

There is a list of over 2500 predefined cities available to choose from. You set
your location by highlighting a city from this list. Each city is represented in
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the world map as a small dot, and when a city is highlighted in the list, a red
crosshairs appears on its location in the map.

It is not practical to scroll through the full list of 2500 locations, looking for a
specific city. To make searches easier, the list can be filtered by entering text in
the boxes below the map. For example, in the screenshot, the text ‘Ba’ appears
in the City Filter box, while ‘M’ has been entered in the Province Filter box, and
‘USA’ is in the Country Filter box. Note that all of the cities displayed in the
list have city, province, and country names that begin with the entered filter
strings, and that the message below the filter boxes indicates that 7 cities are
matched by the filters. Also notice that the dots representing these seven cities
in the map have been colored white, while the unmatched cities remain gray.

The list can also be filtered by location in the map. Clicking anywhere in the
world map will show only those cities within two degrees of the clicked loca-
tion. At this time, you can search by name, or by location, but not both at once.
In other words, when you click on the map, the name filters are ignored, and
vice versa.
The longitude, latitude and time zone information for the currently-selected
location are displayed in the boxes at the bottom of the window. If you feel
that any of these values are inaccurate, you can modify them and press the
Add to List button to record your custom version of the location. You can
also define a completely new location by pressing the Clear Fields button, and
entering the data for the new location. Note that all fields except the optional
State/Province must be filled before the new location can be added to the list.
KStars will automatically load your custom locations for all future sessions.
Please note, at this point, the only way to remove a custom location is to remove
the appropriate line from the file /.kde/share/apps/kstars/mycities.dat.

If you add custom locations (or modify existing ones), please send us your
mycities.dat file so that we can add your locations to the master list.

3.2 Setting the Time

When KStars starts up, the time is set to your computer’s system clock, and
the KStars clock is running to keep up with the real time. If you want to stop
the clock, select Stop Clock from the Time menu, or simply click on the Pause
icon in the toolbar. You can make the clock run slower or faster than normal,
or even make it run backward, using the time-step spinbox in the toolbar. This
spinbox has two sets of up/down buttons. The first one will step through all
83 available time steps, one by one. The second one will skip to the next higher
(or lower) unit of time, which allows you to make large timestep changes more
quickly.

You can set the time and date by selecting Set Time... from the Time menu, or
by pressing the time icon in the toolbar. The Set Time window uses a standard
KDE Date Picker widget, coupled with three spinboxes for setting the hours,
minutes and seconds. If you want to re-synchronize the simulation clock back
to the current CPU time, just select Set Time to Now from the Time menu.
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NOTE
KStars can accept very remote dates beyond the usual limits imposed by QDate.
Currently, you can set the date between the years -50000 and +50000. We may
extend this range even further in future releases. However, please be aware that
the accuracy of the simulation becomes more and more degraded as more remote
dates are examined. This is especially true for the positions of solar system bodies.

3.3 The Configure KStars Window

The Configure KStars window allows you to modify a wide range of display
options. You can access the window with the configure toolbar icon, or by
selecting Configure KStars... from the Settings menu. The window is depicted
below:

The Configure KStars window is divided into five tabs: Catalogs, Guides, Solar
System, Colors, and Advanced.

In the Catalogs tab, you determine which object catalogs are displayed in the
map. The Stars section also allows you to set the ‘faint magnitude limit’ for
stars, and the magnitude limit for displaying the names and/or magnitudes of
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stars. Below the stars section, the Deep-Sky Objects section controls the display
of several non-stellar object catalogs. By default, the list includes the Messier,
NGC and IC catalogs. You can add your own custom object catalogs by press-
ing the Add Custom Catalog button. For detailed instructions on preparing a
catalog data file, see the README.customize file that ships with KStars.

In the Solar System tab, you can specify whether the Sun, Moon, planets,
comets and asteroids are displayed, and whether the major bodies are drawn
as colored circles or actual images. You can also toggle whether solar system
bodies have name labels attached, and control how many of the comets and
asteroids get name labels. There is an option to automatically attach a tempo-
rary ‘orbit trail’ whenever a solar system body is tracked, and another to toggle
whether the color of the orbit trail fades into the background sky color.

The Guides tab lets you toggle whether non-objects are displayed (i.e., constel-
lation lines, constellation names, the Milky Way contour, the celestial equator,
the ecliptic, the horizon line, and the opaque ground). You can also choose
whether you would like to see Latin constellation names, IAU-standard three-
letter abbreviations, or constellation names using your local language.

The Colors tab allows you to set the color scheme, and to define custom color
schemes. The tab is split into two panels:

The left panel shows a list of all display items with adjustable colors. Click on
any item to bring up a color selection window to adjust its color. Below the
list is the Star Color Mode selection box. By default, KStars draws stars with
a realistic color tint according to the spectral type of the star. However, you
may also choose to draw the stars as solid white, black or red circles. If you are
using the realistic star colors, you can set the saturation level of the star colors
with the Star Color Intensity spinbox.

The right panel lists the defined color schemes. There are four predefined
schemes: the Default scheme, Star Chart, which uses black stars on a white
background, Night Vision, which uses only shades of red in order to protect
dark-adapted vision, and Moonless Night, a more realistic, dark theme. Addi-
tionally, you can save the current color settings as a custom scheme by clicking
the Save Current Colors button. It will prompt you for a name for the new
scheme, and then your scheme will appear in the list in all future KStars ses-
sions. To remove a custom scheme, simply highlight it in the list, and press the
Remove Color Scheme button.
The Advanced Tab provides fine-grained control over the more subtle behav-
iors of KStars.
The Correct for atmospheric refraction checkbox controls whether the positions
of objects are corrected for the effects of the atmosphere. Because the atmo-
sphere is a spherical shell, light from outer space is ‘bent’ as it passes through
the atmosphere to our telescopes or eyes on the Earth’s surface. The effect is
largest for objects near the horizon, and actually changes the predicted rise or
set times of objects by a few minutes. In fact, when you ‘see’ a sunset, the
Sun’s actual position is already well below the horizon; atmospheric refraction
makes it seem as if the Sun is still in the sky. Note that atmospheric refraction
is never applied if you are using Equatorial coordinates.
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The Use animating slewing checkbox controls how the display changes when
a new focus position is selected in the map. By default, you will see the sky
drift or ‘slew’ to the new position; if you uncheck this option, then the display
will instead ‘snap’ immediately to the new focus position.

If the Attach label to centered object checkbox is selected, then a name label will
automatically be attached to an object when it is being tracked by the program.
The label will be removed when the object is no longer being tracked. Note
that you can also manually attach a persistent name label to any object with its
popup menu.

There are three situations when KStars must redraw the sky display very rapidly:
when a new focus position is selected (and Use animated slewing is checked),
when the sky is dragged with the mouse, and when the time step is large.
In these situations, the positions of all objects must be recomputed as rapidly
as possible, which can put a large load on the CPU. If the CPU cannot keep up
with the demand, then the display will seem sluggish or jerky. To mitigate this,
KStars will hide certain objects during these rapid-redraw situations, as long
as the Hide objects while moving checkbox is selected. The timestep threshold
above which objects will be hidden is determined by the Also hide if timescale
greater than: timestep-spinbox. You can specify the objects that should be hid-
den in the Configure Hidden Objects group box.

3.4 Customizing the Display

There are several ways to modify the display to your liking.

• Select a different color scheme in the Settings→Color Schemes menu. There
are four predefined color schemes, and you can define your own in the Con-
figure KStars window.

• Toggle whether the Toolbars are drawn in the Settings→ Toolbars menu.
Like most KDE toolbars, they can also be dragged around and anchored on
any window edge, or even detached from the window completely.

• Toggle whether the Info Boxes are drawn in the Settings→ Info Boxes menu.
In addition, you can manipulate the three Info Boxes with the mouse. Each
box has additional lines of data that are hidden by default. You can toggle
whether these additional lines are visible by double-clicking a box to ‘shade’
it. Also, you can reposition a box by dragging it with the mouse. When a box
hits a window edge, it will ‘stick’ to the edge when the window is resized.

• Choose an ‘FOV Symbol’ using the Settings→ FOV Symbols menu. FOV
is an acronym for ‘field-of-view’. An FOV symbol is drawn at the center
of the window to indicate where the display is pointing. Different symbols
have different angular sizes; you can use a symbol to show what the view
through a particular telescope would look like. For example, if you choose
the ‘7x35 Binoculars’ FOV symbol, then a circle is drawn on the display that
is 9.2 degrees in diameter; this is the field-of-view for 7x35 binoculars.
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You can define your own FOV symbols (or modify the existing symbols)
using the Edit FOV Symbols... menu item, which launches the FOV Editor:

The list of defined FOV symbols is displayed on the left. On the right are
buttons for adding a new symbol, editing the highlighted symbol’s proper-
ties, and removing the highlighted symbol from the list. Note that you can
even modify or remove the four predefined symbols (if you remove all sym-
bols, the four defaults will be restored the next time you start KStars). Below
these three buttons is a graphical preview display showing the highlighted
symbol from the list. When the New... or Edit... button is pressed, the New
FOV Symbol window is opened:

16



The KStars Handbook

This window lets you modify the four properties that define a FOV symbol:
name, size, shape, and color. The angular size for the symbol can either be
entered directly in the Field of View edit box, or you can use the Eyepiece/-
Camera Tabs to calculate the field-of-view angle, given parameters of your
telescope/eyepiece or telescope/camera setup. The four available shapes
are: Circle, Square, Crosshairs, and Bullseye. Once you have specified all
four parameters, press Ok, and the symbol will appear in the list of defined
symbols. It will also be available from the Settings | FOV menu.
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Chapter 4

Command Reference

4.1 Menu Commands

4.1.1 File Menu

File→New Window (Ctrl+N) Open another KStars window

File→ Close Window (Ctrl+W) Close KStars window

File→Download Data... (Ctrl+D) Open the Download Extra Data tool

File→Open FITS... (Ctrl+O) Open a FITS image in the FITS Viewer tool

File→ Save Sky Image... (Ctrl+I) Create image on disk from current display

File→ Run Script... (Ctrl+R) Run the specified KStars script

File→ Print... (Ctrl+P) Send the current sky map to the printer (or to a PostScrip-
t/PDF file)

File→Quit (Ctrl+Q) Quit KStars

4.1.2 Time Menu

Time→ Set Time to Now (Ctrl+E) Sync time to system clock

Time→ Set Time... (Ctrl+S) Set time and date

Time→ Start/Stop Clock Toggle whether time passes
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4.1.3 Pointing Menu

Pointing→ Zenith (Z) Center the display at the Zenith point (straight up)

Pointing→North (N) Center the display above the North point on the hori-
zon

Pointing→ East (E) Center the display above the East point on the horizon

Pointing→ South (S) Center the display above the South point on the horizon

Pointing→West (W) Center the display above the West point on the horizon

Pointing→ Set Focus Manually... (Ctrl+M) Center the display on specific sky
coordinates

Pointing→ Find Object (Ctrl+F) Locate an object by name using the Find Ob-
ject Window

Pointing→ Engage/Stop Tracking (Ctrl+T) Toggle tracking on/off. While track-
ing, the display will remain centered on the current position or object.

4.1.4 View Menu

View→ Zoom in (+) Zooms view in

View→ Zoom out (-) Zooms view out

View→Default Zoom (Ctrl+Z) Restore the default Zoom setting

View→ Zoom to Angular Size... (Ctrl+Shift+Z) Zoom to specified field-of-view
angle

View→ Full Screen Mode (Ctrl+Shift+F) Toggle full-screen mode

View→Horizontal/Equatorial Coordinates (Space) Toggle between the Hor-
izontal and Equatorial Coordinate Systems

4.1.5 Devices Menu

Devices→ Telescope Wizard... Opens the Telescope Wizard, which provides
a step-by-step guide to help you connect to your telescope and control it
with KStars.

Devices→ Capture Image Sequence... Acquire images from a CCD camera or
webcam device

Devices→Device Manager Opens up the device manager, which allows you
to start/shutdown device drivers and connect to remote INDI servers.

Devices→ INDI Control Panel Opens up INDI Control Panel, which allows
you to control all the features supported by a device.

Devices→ Configure INDI Opens up a dialog to configure INDI-related fea-
tures such as automatic device updates.
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4.1.6 Tools Menu

Tools→ Calculator... (Ctrl+C) Opens the AstroCalculator Tool, which provides
full access to many of the mathematical functions used by KStars.

Tools→AAVSO Light Curves... (Ctrl+V) Opens the AAVSO Light Curve Gen-
erator Tool, which allows you to download a light curve for any variable
star from the American Association of Variable Star Observers.

Tools→Altitude vs. Time... (Ctrl+A) Opens the Altitude vs. Time Tool, which
can plot curves representing the altitude of any object as a function of
time. This is useful for planning observing sessions.

Tools→What’s Up Tonight... (Ctrl+U) Opens the What’s Up Tonight Tool, which
presents a summary of the objects which are observable from your loca-
tion on a given date.

Tools→ Script Builder... (Ctrl+B) Opens the Script Builder Tool, which pro-
vides a GUI interface for building KStars DCOP scripts.

Tools→ Solar System... (Ctrl+Y) Opens the Solar System Viewer, which dis-
plays an overhead view of the solar system on the current simulation
date.

Tools→ Jupiter’s Moons... (Ctrl+J) Opens the Jupiter Moons Tool, which dis-
plays the positions of Jupiter’s four brightest moons as a function of time.

4.1.7 Settings Menu

Settings→ Info Boxes→Hide/Show Info Boxes Toggle display of all three Info
Boxes

Settings→ Info Boxes→Hide/Show Time Toggle display of the Time Info Box

Settings→ Info Boxes→Hide/Show Focus Toggle display of the Focus Info
Box

Settings→ Info Boxes→Hide/Show Location Toggle display of the Location
Info Box

Settings→ Toolbars→Hide/Show Main Toolbar Toggle display of the Main
Toolbar

Settings→ Toolbars→Hide/Show View Toolbar Toggle display of the View
Toolbar

Settings→ Statusbar→Hide/Show Statusbar Toggle display of the Statusbar

Settings→ Statusbar→Hide/Show Az/Alt field Toggle display of the mouse
cursor’s horizontal coordinates in the statusbar

Settings→ Statusbar→Hide/Show RA/Dec field Toggle display of the mouse
cursor’s horizontal coordinates in the statusbar
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Settings→ Color Schemes This submenu contains all of the defined color schemes,
including your custom schemes. Select any item to set that color scheme.

Settings→ FOV Symbols This submenu lists the available field-of-view (FOV)
Symbols. The FOV Symbol is drawn at the center of the display. You may
choose from the list of predefined symbols (No symbol, 7x35 Binoculars,
One degree, or HST WFPC2), or you may define your own symbols (or
modify existing symbols) using the Edit FOV symbols... item.

Settings→ Set Geographic Location... (Ctrl+G) Select a new geographic lo-
cation

Settings→ Configure KStars... Modify configuration options

4.1.8 Help Menu

Help→KStars Handbook (F1) Invokes the KDE Help system starting at the
KStars help pages. (this document).

Help→What’s This? (Shift+F1) Changes the mouse cursor to a combination
arrow and question mark. Clicking on items within KStars will open a
help window (if one exists for the particular item) explaining the item’s
function.

Help→ Report Bug... Opens the Bug report dialog where you can report a
bug or request a ‘wishlist’ feature.

Help→About KStars This will display version and author information.

Help→About KDE This displays the KDE version and other basic informa-
tion.

4.1.9 Popup Menu

The right click popup menu is context-sensitive, meaning its content varies
depending on what kind of object you click on. We list all possible popup
menu items here, with the relevant object type [in brackets].

[All] Identification and type: The top one to three lines are devoted to the
name(s) of the object, and its type. For stars, the Spectral Type is also
shown here.

[All] Rise, Transit, and Set times for the object on the current simulation date
are shown on the next three lines.

[All] Center and Track: Center the display on this location, and engage track-
ing. Equivalent to double-clicking.
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[All] Angular Distance To...: Enter "angular distance mode". In this mode,
a dotted line is drawn from the first target object to the current mouse
position. When you invoke the popup menu of a second object, this item
will read Compute Angular Distance. Selecting this item will display the
angular distance between the two objects in the statusbar. You can press
the Esc key to exit angular distance mode without measuring an angle.

[All] Details: Open the Object Details window for this object.

[All] Attach Label: Attach a permanent name label to the object. If the object
already has a label attached, this item will read Remove Label.

[All] Show ... Image: download an image of the object from the internet, and
display it in the Image Viewer tool. The "..." text is replaced by a short
description of the image’s source. An object may have multiple image
links available in its popup menu.

[All] ... Page: Display a webpage about the object in your default web browser.
The "..." text is replaced by a short description of the page. An object may
have multiple web links available in its popup menu.

4.2 Keyboard Commands

4.2.1 Navigation Keys

Arrow Keys Use the arrow keys to pan the display. Holding down the Shift
key doubles the scrolling speed.

+ / - Zoom In/Out

Ctrl+Z Restore the default Zoom setting

Ctrl+Shift+Z Zoom to specified field-of-view angle

0–9 Center Display on a major Solar System body:

• 0: Sun
• 1: Mercury
• 2: Venus
• 3: Moon
• 4: Mars
• 5: Jupiter
• 6: Saturn
• 7: Uranus
• 8: Neptune
• 9: Pluto

Z Center the display at the Zenith Point (straight up)
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N Center the display above the North point on the horizon

E Center the display above the East point on the horizon

S Center the display above the South point on the horizon

W Center the display above the West point on the horizon

Ctrl+T Toggle tracking mode

< Advance the simulation clock backwards by one time step

> Advance the simulation clock forwards by one time step

4.2.2 Menu Shortcuts

Ctrl+N Open a new KStars window

Ctrl+W Close a KStars window
Ctrl+D Download extra data
Ctrl+O Open a FITS image in the FITS Editor

Ctrl+I Export sky image to a file

Ctrl+R Run a KStars DBus script

Ctrl+P Print the current sky map

Ctrl+Q Quit KStars

Ctrl+E Sync the simulation clock with the current system time

Ctrl+S Set the simulation clock to a specified Time and Date

Ctrl+Shift+F Toggle full-screen mode

Space Toggle between the Horizontal and Equatorial Coordinate Systems

F1 Open the KStars Handbook

4.2.3 Actions for the Selected Object

Each of the following keystrokes performs an action on the selected object. The
selected object is the last object which was clicked on (identified in the status
bar). Alternatively, if you hold down the Shift key, then the action is performed
on the centered object instead.

D Open the Details window for the selected object

L Toggle a name label for the selected object

O Add the selected object to the observing list

P Open the selected object’s popup menu

T Toggle a trail on the selected object (solar system bodies only)
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4.2.4 Tools Shortcuts

Ctrl+F Open the Find Object window, for specifying a sky object on which to
center

Ctrl+M Open the Set Manual Focus tool, for specifying RA/Dec or Az/Alt
coordinates on which to center

[ / ] Start/End an Angular Distance measurement at the current mouse cursor
position. The angular distance between start and end points is displayed
in the statusbar.

Ctrl+G Open the Set Geographic Location window

Ctrl+C Open the AstroCalculator

Ctrl+V Open the AAVSO Lightcurve Generator

Ctrl+A Open the Altitude vs. Time tool

Ctrl+U Open the What’s Up Tonight? tool

Ctrl+B Open the Script Builder tool

Ctrl+Y Open the Solar System Viewer

Ctrl+J Open the Jupiter Moons tool

Ctrl+L Open the Observing List tool

4.3 Mouse Commands

Moving the mouse The sky coordinates (RA/Dec and Az/Alt) of the mouse
cursor are updated in the status bar

"Hovering" the mouse A temporary name label is attached to the object near-
est to the mouse cursor.

Left-clicking The object nearest the mouse click is identified in the status bar.

Double-clicking Center and track on the location or object nearest the mouse
click. Double-clicking on an Info Box will ‘shade’ it to show/hide extra
information.

Right-clicking Open the popup menu for the location or object nearest the
mouse cursor.

Scrolling the mouse wheel Zoom the display in or out. If you do not have a
mouse wheel, you can hold the middle mouse button and drag vertically.

Click-and-dragging

Dragging the sky map Pan the display, following the drag motion.
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Ctrl+dragging the sky map Define a rectangle in the map. When the
mouse button is released, the display is zoomed in to match the
field-of-view to the bounds of the rectangle.

Dragging an Info Box The Info Box is repositioned in the map. Info
Boxes will ‘stick’ to window edges, so that they remain on the edge
when the window is resized.
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Chapter 5

The AstroInfo Project

Here you can find a collection of short articles that explain various astronom-
ical concepts used in KStars. From coordinate systems to celestial mechanics,
you can find answers to your questions here.

The articles sometimes also contain exercises that you can perform with KStars
to illustrate the concept behind the article.

5.1 AstroInfo: Table of Contents

THE SKY AND COORDINATE SYSTEMS

• Celestial Coordinate Systems

• Celestial Equator

• Celestial Poles

• Celestial Sphere

• The Ecliptic

• The Equinoxes

• Geographic Coordinates

• Great Circles

• The Horizon

• Hour Angle

• Local Meridian

• Precession
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• The Zenith

TIME

• Julian Day

• Leap Years

• Sidereal Time

• Time Zones

• Universal Time

PHYSICS

• Blackbody Radiation

• Dark Matter

• Flux

• Luminosity

• Parallax

• Retrograde Motion

ASTROPHYSICS

• Elliptical Galaxies

• Spiral Galaxies

• The Magnitude Scale

• Stars: An Introductory FAQ

• Star Colors and Temperatures

5.2 Celestial Coordinate Systems

A basic requirement for studying the heavens is determining where in the sky
things are. To specify sky positions, astronomers have developed several coor-
dinate systems. Each uses a coordinate grid projected on the Celestial Sphere,
in analogy to the Geographic coordinate system used on the surface of the
Earth. The coordinate systems differ only in their choice of the fundamental
plane, which divides the sky into two equal hemispheres along a great circle.
(the fundamental plane of the geographic system is the Earth’s equator). Each
coordinate system is named for its choice of fundamental plane.
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5.2.1 The Equatorial Coordinate System

The Equatorial coordinate system is probably the most widely used celestial coor-
dinate system. It is also the most closely related to the Geographic coordinate
system, because they use the same fundamental plane, and the same poles. The
projection of the Earth’s equator onto the celestial sphere is called the Celestial
Equator. Similarly, projecting the geographic Poles onto the celestial sphere
defines the North and South Celestial Poles.
However, there is an important difference between the equatorial and geo-
graphic coordinate systems: the geographic system is fixed to the Earth; it
rotates as the Earth does. The Equatorial system is fixed to the stars1, so it
appears to rotate across the sky with the stars, but of course it is really the
Earth rotating under the fixed sky.

The latitudinal (latitude-like) angle of the Equatorial system is called Declination
(Dec for short). It measures the angle of an object above or below the Celestial
Equator. The longitudinal angle is called the Right Ascension (RA for short). It
measures the angle of an object East of the Vernal Equinox. Unlike longitude,
Right Ascension is usually measured in hours instead of degrees, because the
apparent rotation of the Equatorial coordinate system is closely related to Side-
real Time and Hour Angle. Since a full rotation of the sky takes 24 hours to
complete, there are (360 degrees / 24 hours) = 15 degrees in one Hour of Right
Ascension.

5.2.2 The Horizontal Coordinate System

The Horizontal coordinate system uses the observer’s local horizon as the Fun-
damental Plane. This conveniently divides the sky into the upper hemisphere
that you can see, and the lower hemisphere that you can’t (because the Earth
is in the way). The pole of the upper hemisphere is called the Zenith. The pole
of the lower hemisphere is called the nadir. The angle of an object above or
below the horizon is called the Altitude (Alt for short). The angle of an object
around the horizon (measured from the North point, toward the East) is called
the Azimuth. The Horizontal Coordinate System is sometimes also called the
Alt/Az Coordinate System.

The Horizontal Coordinate System is fixed to the Earth, not the Stars. There-
fore, the Altitude and Azimuth of an object changes with time, as the object
appears to drift across the sky. In addition, because the Horizontal system is
defined by your local horizon, the same object viewed from different locations
on Earth at the same time will have different values of Altitude and Azimuth.
Horizontal coordinates are very useful for determining the Rise and Set times
of an object in the sky. When an object has Altitude=0 degrees, it is either Rising
(if its Azimuth is < 180 degrees) or Setting (if its Azimuth is > 180 degrees).

1

actually, the equatorial coordinates are not quite fixed to the stars. See precession. Also, if Hour
Angle is used in place of Right Ascension, then the Equatorial system is fixed to the Earth, not to
the stars.
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5.2.3 The Ecliptic Coordinate System

The Ecliptic coordinate system uses the Ecliptic for its Fundamental Plane. The
Ecliptic is the path that the Sun appears to follow across the sky over the course
of a year. It is also the projection of the Earth’s orbital plane onto the Celestial
Sphere. The latitudinal angle is called the Ecliptic Latitude, and the longitudinal
angle is called the Ecliptic Longitude. Like Right Ascension in the Equatorial
system, the zeropoint of the Ecliptic Longitude is the Vernal Equinox.

What do you think such a coordinate system would be useful for? If you
guessed charting solar system objects, you are right! Each of the planets (ex-
cept Pluto) orbits the Sun in roughly the same plane, so they always appear to
be somewhere near the Ecliptic (i.e., they always have small ecliptic latitudes).

5.2.4 The Galactic Coordinate System

The Galactic coordinate system uses the Milky Way as its Fundamental Plane.
The latitudinal angle is called the Galactic Latitude, and the longitudinal angle
is called the Galactic Longitude. This coordinate system is useful for studying
the Galaxy itself. For example, you might want to know how the density of
stars changes as a function of Galactic Latitude, to how much the disk of the
Milky Way is flattened.

5.3 The Celestial Equator

The Celestial Equator is an imaginary great circle on the celestial sphere. The
celestial equator is the fundamental plane of the Equatorial Coordinate System,
so it is defined as the locus of points with Declination of zero degrees. It is also
the projection of the Earth’s equator onto the sky.

The Celestial Equator and the Ecliptic are set at an angle of 23.5 degrees in the
sky. The points where they intersect are the Vernal and Autumnal Equinoxes.

5.4 The Celestial Poles

The sky appears to drift overhead from east to west, completing a full circuit
around the sky in 24 (Sidereal) hours. This phenomenon is due to the spinning
of the Earth on its axis. The Earth’s spin axis intersects the Celestial Sphere
at two points. These points are the Celestial Poles. As the Earth spins; they
remain fixed in the sky, and all other points seem to rotate around them. The
celestial poles are also the poles of the Equatorial Coordinate System, meaning
they have Declinations of +90 degrees and -90 degrees (for the North and South
celestial poles, respectively).
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The North Celestial Pole currently has nearly the same coordinates as the bright
star Polaris (which is Latin for ‘Pole Star’). This makes Polaris useful for naviga-
tion: not only is it always above the North point of the horizon, but its Altitude
angle is always (nearly) equal to the observer’s Geographic Latitude (however,
Polaris can only be seen from locations in the Northern hemisphere).

The fact that Polaris is near the pole is purely a coincidence. In fact, because of
Precession, Polaris is only near the pole for a small fraction of the time.

TIP
Exercises:
Use the Find Object window (Ctrl+F) to locate Polaris. Notice that its Declination is
almost (but not exactly) +90 degrees. Compare the Altitude reading when focused
on Polaris to your location’s geographic latitude. They are always within one degree
of each other. They are not exactly the same because Polaris isn’t exactly at the
Pole. (you can point exactly at the pole by switching to Equatorial coordinates, and
pressing the up-arrow key until the sky stops scrolling).
Use the Time Step spinbox in the toolbar to accelerate time to a step of 100 sec-
onds. You can see the entire sky appears to rotate around Polaris, while Polaris
itself remains nearly stationary.
We said that the celestial pole is the pole of the Equatorial coordinate system. What
do you think is the pole of the horizontal (Altitude/Azimuth) coordinate system? (The
Zenith).

5.5 The Celestial Sphere

The celestial sphere is an imaginary sphere of gigantic radius, centered on the
Earth. All objects which can be seen in the sky can be thought of as lying on
the surface of this sphere.

Of course, we know that the objects in the sky are not on the surface of a sphere
centered on the Earth, so why bother with such a construct? Everything we see
in the sky is so very far away, that their distances are impossible to gauge just
by looking at them. Since their distances are indeterminate, you only need to
know the direction toward the object to locate it in the sky. In this sense, the
celestial sphere model is a very practical model for mapping the sky.

The directions toward various objects in the sky can be quantified by construct-
ing a Celestial Coordinate System.

5.6 The Ecliptic

The ecliptic is an imaginary Great Circle on the Celestial Sphere along which
the Sun appears to move over the course of a year. Of course, it is really the
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Earth’s orbit around the Sun causing the change in the Sun’s apparent direc-
tion. The ecliptic is inclined from the Celestial Equator by 23.5 degrees. The
two points where the Ecliptic crosses the Celestial Equator are known as the
Equinoxes.

Since our solar system is relatively flat, the orbits of the planets are also close
to the plane of the ecliptic. In addition, the constellations of the zodiac are
located along the ecliptic. This makes the ecliptic a very useful line of reference
to anyone attempting to locate the planets or the constellations of the zodiac,
since they all literally ‘follow the Sun’.

Because of the 23.5-degree tilt of the Ecliptic, the Altitude of the Sun at noon
changes over the course of the year, as it follows the path of the Ecliptic across
the sky. This causes the seasons. In the Summer, the Sun is high in the sky at
noon, and it remains above the Horizon for more than twelve hours. Whereas,
in the winter, the Sun is low in the sky at noon, and remains above the Hori-
zon for less than twelve hours. In addition, sunlight is received at the Earth’s
surface at a more direct angle in the Summer, which means that a given area
at the surface receives more energy per second in the Summer than in Winter.
The differences in day duration and in energy received per unit area lead to the
differences in temperature we experience in Summer and Winter.

TIP
Exercises:
Make sure your location is set to somewhere that is not very near the equator
for these experiments. Open the Configure KStars window, and switch to Hori-
zontal coordinates, with the Opaque Ground shown. Open the Set Time window
(Ctrl+S),and change the Date to sometime in the middle of Summer, and the Time
to 12:00 Noon. Back in the Main Window, point toward the Southern Horizon (press
S). Note the height of the Sun above the Horizon at Noon in the Summer. Now,
change the Date to something in the middle of Winter (but keep the Time at 12:00
Noon). The Sun is now much lower in the Sky. You will also notice that the day
durations are different if you open the What’s Up Tonight? tool for each date.

5.7 The Equinoxes

Most people know the Vernal and Autumnal Equinoxes as calendar dates, sig-
nifying the beginning of the Northern hemisphere’s Spring and Autumn, re-
spectively. Did you know that the equinoxes are also positions in the sky?

The Celestial Equator and the Ecliptic are two Great Circles on the Celestial
Sphere, set at an angle of 23.5 degrees. The two points where they intersect
are called the Equinoxes. The Vernal Equinox has coordinates RA=0.0 hours,
Dec=0.0 degrees. The Autumnal Equinox has coordinates RA=12.0 hours, Dec=0.0
degrees.

The Equinoxes are important for marking the seasons. Because they are on the
Ecliptic, the Sun passes through each equinox every year. When the Sun passes
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through the Vernal Equinox (usually on March 21st), it crosses the Celestial
Equator from South to North, signifying the end of Winter for the Northern
hemisphere. Similarly, whenthe Sun passes through the Autumnal Equinox
(usually on September 21st), it crosses the Celestial Equator from North to
South, signifying the end of Winter for the Southern hemisphere.

5.8 Geographic Coordinates

Locations on Earth can be specified using a spherical coordinate system. The
geographic (‘earth-mapping’) coordinate system is aligned with the spin axis
of the Earth. It defines two angles measured from the center of the Earth. One
angle, called the Latitude, measures the angle between any point and the Equa-
tor. The other angle, called the Longitude, measures the angle along the Equator
from an arbitrary point on the Earth (Greenwich, England is the accepted zero-
longitude point in most modern societies).

By combining these two angles, any location on Earth can be specified. For ex-
ample, Baltimore, Maryland (USA) has a latitude of 39.3 degrees North, and a
longitude of 76.6 degrees West. So, a vector drawn from the center of the Earth
to a point 39.3 degrees above the Equator and 76.6 degrees west of Greenwich,
England will pass through Baltimore.

The Equator is obviously an important part of this coordinate system; it rep-
resents the zeropoint of the latitude angle, and the halfway point between the
poles. The Equator is the Fundamental Plane of the geographic coordinate sys-
tem. All Spherical Coordinate Systems define such a Fundamental Plane.

Lines of constant Latitude are called Parallels. They trace circles on the surface
of the Earth, but the only parallel that is a Great Circle is the Equator (Lati-
tude=0 degrees). Lines of constant Longitude are called Meridians. The Merid-
ian passing through Greenwich is the Prime Meridian (longitude=0 degrees).
Unlike Parallels, all Meridians are great circles, and Meridians are not parallel:
they intersect at the north and south poles.

TIP
Exercise:
What is the longitude of the North Pole? Its latitude is 90 degrees North.
This is a trick question. The Longitude is meaningless at the north pole (and the
south pole too). It has all longitudes at the same time.

5.9 Great Circles

Consider a sphere, such as the Earth, or the Celestial Sphere. The intersection
of any plane with the sphere will result in a circle on the surface of the sphere.
If the plane happens to contain the center of the sphere, the intersection circle is
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a Great Circle. Great circles are the largest circles that can be drawn on a sphere.
Also, the shortest path between any two points on a sphere is always along a
great circle.

Some examples of great circles on the celestial sphere include: the Horizon, the
Celestial Equator, and the Ecliptic.

5.10 The Horizon

The Horizon is the line that separates Earth from Sky. More precisely, it is the
line that divides all of the directions you can possibly look into two categories:
those which intersect the Earth, and those which do not. At many locations,
the Horizon is obscured by trees, buildings, mountains, etc.. However, if you
are on a ship at sea, the Horizon is strikingly apparent.

The horizon is the Fundamental Plane of the Horizontal Coordinate System. In
other words, it is the locus of points which have an Altitude of zero degrees.

5.11 Hour Angle

As explained in the Sidereal Time article, the Right Ascension of an object in-
dicates the Sidereal Time at which it will transit across your Local Meridian.
An object’s Hour Angle is defined as the difference between the current Local
Sidereal Time and the Right Ascension of the object:

HAobj = LST - RAobj

Thus, the object’s Hour Angle indicates how much Sidereal Time has passed
since the object was on the Local Meridian. It is also the angular distance be-
tween the object and the meridian, measured in hours (1 hour = 15 degrees).
For example, if an object has an hour angle of 2.5 hours, it transited across the
Local Meridian 2.5 hours ago, and is currently 37.5 degrees West of the Merid-
ian. Negative Hour Angles indicate the time until the next transit across the
Local Meridian. Of course, an Hour Angle of zero means the object is currently
on the Local Meridian.

5.12 The Local Meridian

The Local Meridian is an imaginary Great Circle on the Celestial Sphere that is
perpendicular to the local Horizon. It passes through the North point on the
Horizon, through the Celestial Pole, up to the Zenith, and through the South
point on the Horizon.

Because it is fixed to the local Horizon, stars will appear to drift past the Local
Meridian as the Earth spins. You can use an object’s Right Ascension and the
Local Sidereal Time to determine when it will cross your Local Meridian (see
Hour Angle).

33



The KStars Handbook

5.13 Precession

Precession is the gradual change in the direction of the Earth’s spin axis. The
spin axis traces a cone, completing a full circuit in 26,000 years. If you have
ever spun a top or a dreidel, the ‘wobbling’ rotation of the top as it spins is
precession.

Because the direction of the Earth’s spin axis changes, so does the location of
the Celestial Poles.
The reason for the Earth’s precession is complicated. The Earth is not a perfect
sphere, it is a bit flattened, meaning the Great Circle of the equator is longer
than a ‘meridonal’ great circle that passes through the poles. Also, the Moon
and Sun lie outside the Earth’s Equatorial plane. As a result, the gravitational
pull of the Moon and Sun on the oblate Earth induces a slight torque in addition
to a linear force. This torque on the spinning body of the Earth leads to the
precessional motion.

TIP
Exercise:
Precession is easiest to see by observing the Celestial Pole. To find the pole, first
switch to Equatorial Coordinates in the Configure KStars window, and then hold
down the Up arrow key until the display stops scrolling. The declination displayed
in the center of the Info Panel should be +90 degrees, and the bright star Polaris
should be nearly at the center of the screen. Try slewing with the left and right arrow
keys. Notice that the sky appears to rotate around the Pole.
We will now demonstrate Precession by changing the Date to a very remote year,
and observing that the location of the Celestial Pole is no longer near Polaris. Open
the Set Time window (Ctrl+S), and set the date to the year 8000 (currently, KStars
cannot handle dates much more remote than this, but this date is sufficient for our
purposes). Notice that the sky display is now centered at a point between the
constellations Cygnus and Cepheus. Verify that this is actually the pole by slewing
left and right: the sky rotates about this point; in the year 8000, the North celestial
pole will no longer be near Polaris.

5.14 The Zenith

The Zenith is the point in the sky where you are looking when you look ‘straight
up’ from the ground. More precisely, it is the point on the sky with an Altitude
of +90 Degrees; it is the Pole of the Horizontal Coordinate System. Geometri-
cally, it is the point on the Celestial Sphere intersected by a line drawn from the
center of the Earth through your location on the Earth’s surface.

The Zenith is, by definition, a point along the Local Meridian.
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TIP
Exercise:
You can point to the Zenith by pressing Z or by selecting Zenith from the Location
menu.

5.15 Julian Day

Julian Days are a way of reckoning the current date by a simple count of the
number of days that have passed since some remote, arbitrary date. This num-
ber of days is called the Julian Day, abbreviated as JD. The starting point, JD=0,
is January 1, 4713 BC (or -4712 January 1, since there was no year ’0’). Ju-
lian Days are very useful because they make it easy to determine the number
of days between two events by simply subtracting their Julian Day numbers.
Such a calculation is difficult for the standard (Gregorian) calendar, because
days are grouped into months, which contain a variable number of days, and
there is the added complication of Leap Years.

Converting from the standard (Gregorian) calendar to Julian Days and vice
versa is best left to a special program written to do this, such as the KStars
Astrocalculator. However, for those interested, here is a simple example of a
Gregorian to Julian day converter:

JD = D - 32075 + 1461*( Y + 4800 + ( M - 14 ) / 12 ) / 4 + 367*( M - 2 - ( M - 14 )
/ 12 * 12 ) / 12 - 3*( ( Y + 4900 + ( M - 14 ) / 12 ) / 100 ) / 4
where D is the day (1-31), M is the Month (1-12), and Y is the year (1801-2099).
Note that this formula only works for dates between 1801 and 2099. More
remote dates require a more complicated transformation.

An example Julian Day is: JD 2440588, which corresponds to 1 Jan, 1970.

Julian Days can also be used to tell time; the time of day is expressed as a
fraction of a full day, with 12:00 noon (not midnight) as the zero point. So,
3:00 pm on 1 Jan 1970 is JD 2440588.125 (since 3:00 pm is 3 hours since noon,
and 3/24 = 0.125 day). Note that the Julian Day is always determined from
Universal Time, not Local Time.
Astronomers use certain Julian Day values as important reference points, called
Epochs. One widely-used epoch is called J2000; it is the Julian Day for 1 Jan,
2000 at 12:00 noon = JD 2451545.0.
Much more information on Julian Days is available on the internet. A good
starting point is the U.S. Naval Observatory. If that site is not available when
you read this, try searching for ‘Julian Day’ with your favorite search engine.

5.16 Leap Years

The Earth has two major components of motion. First, it spins on its rotational
axis; a full spin rotation takes one Day to complete. Second, it orbits around
the Sun; a full orbital rotation takes one Year to complete.
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There are normally 365 days in one calendar year, but it turns out that a true
year (i.e., a full orbit of the Earth around the Sun; also called a tropical year) is
a little bit longer than 365 days. In other words, in the time it takes the Earth
to complete one orbital circuit, it completes 365.24219 spin rotations. Do not be
too surprised by this; there is no reason to expect the spin and orbital motions
of the Earth to be synchronized in any way. However, it does make marking
calendar time a bit awkward....
What would happen if we simply ignored the extra 0.24219 rotation at the end
of the year, and simply defined a calendar year to always be 365.0 days long?
The calendar is basically a charting of the Earth’s progress around the Sun. If
we ignore the extra bit at the end of each year, then with every passing year,
the calendar date lags a little more behind the true position of Earth around the
Sun. In just a few decades, the dates of the solstices and equinoxes will have
drifted noticeably.

In fact, it used to be that all years were defined to have 365.0 days, and the
calendar ‘drifted’ away from the true seasons as a result. In the year 46 BCE,
Julius Caeser established the Julian Calendar, which implemented the world’s
first leap years: He decreed that every 4th year would be 366 days long, so that a
year was 365.25 days long, on average. This basically solved the calendar drift
problem.

However, the problem wasn’t completely solved by the Julian calendar, be-
cause a tropical year isn’t 365.25 days long; it’s 365.24219 days long. You
still have a calendar drift problem, it just takes many centuries to become
noticeable. And so, in 1582, Pope Gregory XIII instituted the Gregorian cal-
endar, which was largely the same as the Julian Calendar, with one more trick
added for leap years: even Century years (those ending with the digits ‘00’) are
only leap years if they are divisible by 400. So, the years 1700, 1800, and 1900
were not leap years (though they would have been under the Julian Calendar),
whereas the year 2000 was a leap year. This change makes the average length
of a year 365.2425 days. So, there is still a tiny calendar drift, but it amounts to
an error of only 3 days in 10,000 years. The Gregorian calendar is still used as
a standard calendar throughout most of the world.

NOTE
Fun Trivia: When Pope Gregory instituted the Gregorian Calendar, the Julian Cal-
endar had been followed for over 1500 years, and so the calendar date had already
drifted by over a week. Pope Gregory re-synchronized the calendar by simply elim-
inating 10 days: in 1582, the day after October 4th was October 15th!

5.17 Sidereal Time

Sidereal Time literally means ‘star time’. The time we are used to using in our
everyday lives is Solar Time. The fundamental unit of Solar Time is a Day: the
time it takes the Sun to travel 360 degrees around the sky, due to the rotation
of the Earth. Smaller units of Solar Time are just divisions of a Day:
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• 1/24 Day = 1 Hour

• 1/60 Hour = 1 Minute

• 1/60 Minute = 1 Second

However, there is a problem with Solar Time. The Earth does not actually spin
around 360 degrees in one Solar Day. The Earth is in orbit around the Sun,
and over the course of one day, it moves about one Degree along its orbit (360
degrees/365.25 Days for a full orbit = about one Degree per Day). So, in 24
hours, the direction toward the Sun changes by about a Degree. Therefore,
the Earth has to spin 361 degrees to make the Sun look like it has traveled 360
degrees around the Sky.

In astronomy, we are concerned with how long it takes the Earth to spin with
respect to the ‘fixed’ stars, not the Sun. So, we would like a timescale that re-
moves the complication of Earth’s orbit around the Sun, and just focuses on
how long it takes the Earth to spin 360 degrees with respect to the stars. This
rotational period is called a Sidereal Day. On average, it is 4 minutes shorter
than a Solar Day, because of the extra 1 degree the Earth spins in a Solar Day.
Rather than defining a Sidereal Day to be 23 hours, 56 minutes, we define Side-
real Hours, Minutes and Seconds that are the same fraction of a Day as their
Solar counterparts. Therefore, one Solar Second = 1.00278 Sidereal Seconds.

The Sidereal Time is useful for determining where the stars are at any given
time. Sidereal Time divides one full spin of the Earth into 24 Sidereal Hours;
similarly, the map of the sky is divided into 24 Hours of Right Ascension. This
is no coincidence; Local Sidereal Time (LST) indicates the Right Ascension on
the sky that is currently crossing the Local Meridian. So, if a star has a Right
Ascension of 05h 32m 24s, it will be on your meridian at LST=05:32:24. More
generally, the difference between an object’s RA and the Local Sidereal Time
tells you how far from the Meridian the object is. For example, the same object
at LST=06:32:24 (one Sidereal Hour later), will be one Hour of Right Ascension
west of your meridian, which is 15 degrees. This angular distance from the
meridian is called the object’s Hour Angle.

TIP
The Local Sidereal Time is displayed by KStars in the Time Info Box, with the label
‘ST’ (you have to ‘unshade’ the box by double-clicking it in order to see the side-
real time). Note that the changing sidereal seconds are not synchronized with the
changing Local Time and Universal Time seconds. In fact, if you watch the clocks
for a while, you will notice that the Sidereal seconds really are slightly shorter than
the LT and UT seconds.
Point to the Zenith (press Z or select Zenith from the Location menu). The Zenith is
the point on the sky where you are looking ‘straight up’ from the ground, and it is a
point on your Local Meridian. Note the Right Ascension of the Zenith: it is exactly
the same as your Local Sidereal Time.
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5.18 Time Zones

The Earth is round, and it is always half-illuminated by the Sun. However, be-
cause the Earth is spinning, the half that is illuminated is always changing. We
experience this as the passing of days wherever we are on the Earth’s surface.
At any given instant, there are places on the Earth passing from the dark half
into the illuminated half (which is seen as dawn on the surface). At the same in-
stant, on the opposite side of the Earth, points are passing from the illuminated
half into darkness (which is seen as dusk at those locations). So, at any given
time, different places on Earth are experiencing different parts of the day. Thus,
Solar time is defined locally, so that the clock time at any location describes the
part of the day consistently.

This localization of time is accomplished by dividing the globe into 24 vertical
slices called Time Zones. The Local Time is the same within any given zone,
but the time in each zone is one Hour earlier than the time in the neighboring
Zone to the East. Actually, this is a idealized simplification; real Time Zone
boundaries are not straight vertical lines, because they often follow national
boundaries and other political considerations.

Note that because the Local Time always increases by an hour when moving
between Zones to the East, by the time you move through all 24 Time Zones,
you are a full day ahead of where you started. We deal with this paradox
by defining the International Date Line, which is a Time Zone boundary in the
Pacific Ocean, between Asia and North America. Points just to the East of
this line are 24 hours behind the points just to the West of the line. This leads
to some interesting phenomena. A direct flight from Australia to California
arrives before it departs. Also, the islands of Fiji straddle the International
Date Line, so if you have a bad day on the West side of Fiji, you can go over to
the East side of Fiji and have a chance to live the same day all over again.

5.19 Universal Time

The time on our clocks is essentially a measurement of the current position of
the Sun in the sky, which is different for places at different Longitudes because
the Earth is round (see Time Zones).

However, it is sometimes necessary to define a global time, one that is the same
for all places on Earth. One way to do this is to pick a place on the Earth, and
adopt the Local Time at that place as the Universal Time, abbreviated UT. (The
name is a bit of a misnomer, since Universal Time has little to do with the
Universe. It would perhaps be better to think of it as global time).

The geographic location chosen to represent Universal Time is Greenwich, Eng-
land. The choice is arbitrary and historical. Universal Time became an impor-
tant concept when European ships began to sail the wide open seas, far from
any known landmarks. A navigator could reckon the ship’s longitude by com-
paring the Local Time (as measured from the Sun’s position) to the time back
at the home port (as kept by an accurate clock on board the ship). Greenwich
was home to England’s Royal Observatory, which was charged with keeping
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time very accurately, so that ships in port could re-calibrate their clocks before
setting sail.

TIP
Exercise:
Set the geographic location to ‘Greenwich, England’ using the Set Location window
(Ctrl+G). Note that the Local Time (LT)and the Universal Time (UT) are now the
same.
Further Reading: The history behind the construction of the first clock that was
accurate and stable enough to be used on ships to keep Universal Time is a fasci-
nating tale, and one told expertly in the book ‘Longitude’, by Dava Sobel.

5.20 Blackbody Radiation

A blackbody refers to an opaque object that emits thermal radiation. A perfect
blackbody is one that absorbs all incoming light and does not reflect any. At
room temperature, such an object would appear to be perfectly black (hence
the term blackbody). However, if heated to a high temperature, a blackbody
will begin to glow with thermal radiation.

In fact, all objects emit thermal radiation (as long as their temperature is above
Absolute Zero, or -273.15 degrees Celsius), but no object emits thermal radia-
tion perfectly; rather, they are better at emitting/absorbing some wavelengths
of light than others. These uneven efficiencies make it difficult to study the
interaction of light, heat and matter using normal objects.

Fortunately, it is possible to construct a nearly-perfect blackbody. Construct a
box made of a thermally conductive material, such as metal. The box should
be completely closed on all sides, so that the inside forms a cavity that does
not receive light from the surroundings. Then, make a small hole somewhere
on the box. The light coming out of this hole will almost perfectly resemble the
light from an ideal blackbody, for the temperature of the air inside the box.

At the beginning of the 20th century, scientists Lord Rayleigh, and Max Planck
(among others) studied the blackbody radiation using such a device. After
much work, Planck was able to empirically describe the intensity of light emit-
ted by a blackbody as a function of wavelength. Furthermore, he was able to
describe how this spectrum would change as the temperature changed. Planck’s
work on blackbody radiation is one of the areas of physics that led to the foun-
dation of the wonderful science of Quantum Mechanics, but that is unfortu-
nately beyond the scope of this article.

What Planck and the others found was that as the temperature of a blackbody
increases, the total amount of light emitted per second increases, and the wave-
length of the spectrum’s peak shifts to bluer colors (see Figure 1).
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Figure 1

For example, an iron bar becomes orange-red when heated to high tempera-
tures and its color progressively shifts toward blue and white as it is heated
further.
In 1893, German physicist Wilhelm Wien quantified the relationship between
blackbody temperature and the wavelength of the spectral peak with the fol-
lowing equation:

where T is the temperature in Kelvin. Wien’s law (also known as Wien’s dis-
placement law) states that the wavelength of maximum emission from a black-
body is inversely proportional to its temperature. This makes sense; shorter-
wavelength (higher-frequency) light corresponds to higher-energy photons,
which you would expect from a higher-temperature object.

For example, the sun has an average temperature of 5800 K, so its wavelength
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of maximum emission is given by:

This wavelengths falls in the green region of the visible light spectrum, but the
sun’s continuum radiates photons both longer and shorter than lambda(max)
and the human eyes perceives the sun’s color as yellow/white.

In 1879, Austrian physicist Stephan Josef Stefan showed that the luminosity, L,
of a black body is proportional to the 4th power of its temperature T.

where A is the surface area, alpha is a constant of proportionality, and T is the
temperature in Kelvin. That is, if we double the temperature (e.g. 1000 K to
2000 K) then the total energy radiated from a blackbody increase by a factor of
2ˆ4 or 16.
Five years later, Austrian physicist Ludwig Boltzman derived the same equa-
tion and is now known as the Stefan-Boltzman law. If we assume a spherical
star with radius R, then the luminosity of such a star is

where R is the star radius in cm, and the alpha is the Stefan-Boltzman constant,
which has the value:

5.21 Dark Matter

Scientists are now quite comfortable with the idea that 90% of the mass in the
universe is in a form of matter that cannot be seen.
Despite comprehensive maps of the nearby universe that cover the spectrum
from radio to gamma rays, we are only able to account of 10% of the mass that
must be out there. As Bruce H. Margon, an astronomer at the University of
Washington, told the New York Times in 2001: [?].

The term given this ‘missing mass’ is Dark Matter, and those two words pretty
well sum up everything we know about it at this point. We know there is ‘Mat-
ter’, because we can see the effects of its gravitational influence. However, the
matter emits no detectable electromagnetic radiation at all, hence it is ‘Dark’.
There exist several theories to account for the missing mass ranging from ex-
otic subatomic particles, to a population of isolated black holes, to less exotic
brown and white dwarfs. The term ‘missing mass’ might be misleading, since
the mass itself is not missing, just its light. But what is exactly dark matter and
how do we really know it exists, if we cannot see it?
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The story began in 1933 when Astronomer Fritz Zwicky was studying the mo-
tions of distant and massive clusters of galaxies, specifically the Coma cluster
and the Virgo cluster. Zwicky estimated the mass of each galaxy in the cluster
based on their luminosity, and added up all of the galaxy masses to get a to-
tal cluster mass. He then made a second, independent estimate of the cluster
mass, based on measuring the spread in velocities of the individual galaxies in
the cluster. To his suprise, this second dynamical mass estimate was 400 times
larger than the estimate based on the galaxy light.

Although the evidence was strong at Zwicky’s time, it was not until the 1970s
that scientists began to explore this discrepancy comprehensively. It was at this
time that the existence of Dark Matter began to be taken seriously. The exis-
tence of such matter would not only resolve the mass deficit in galaxy clusters;
it would also have far more reaching consequences for the evolution and fate
of the universe itself.
Another phenomenon that suggested the need for dark matter is the rotational
curves of Spiral Galaxies. Spiral Galaxies contain a large population of stars
that orbit the Galactic center on nearly circular orbits, much like planets orbit a
star. Like planetary orbits, stars with larger galactic orbits are expected to have
slower orbital speeds (this is just a statement of Kepler’s 3rd Law). Actually,
Kepler’s 3rd Law only applies to stars near the perimeter of a Spiral Galaxy,
because it assumes the mass enclosed by the orbit to be constant.

However, astronomers have made observations of the orbital speeds of stars in
the outer parts of a large number of spiral galaxies, and none of them follow
Kepler’s 3rd Law as expected. Instead of falling off at larger radii, the orbital
speeds remain remarkably constant. The implication is that the mass enclosed
by larger-radius orbits increases, even for stars that are apparently near the
edge of the galaxy. While they are near the edge of the luminous part of the
galaxy, the galaxy has a mass profile that apparently continues well beyond the
regions occupied by stars.

Here is another way to think about it: Consider the stars near the perimeter
of a spiral galaxy, with typical observed orbital velocities of 200 kilometers per
second. If the galaxy consisted of only the matter that we can see, these stars
would very quickly fly off from the galaxy, because their orbital speeds are four
times larger than the galaxy’s escape velocity. Since galaxies are not seen to be
spinning apart, there must be mass in the galaxy that we are not accounting for
when we add up all the parts we can see.

Several theories have surfaced in literature to account for the missing mass
such as WIMPs (Weakly Interacting Massive Particles), MACHOs (MAssive
Compact Halo Objects), primordial black holes, massive neutrinos, and others;
each with their pros and cons. No single theory has yet been accepted by the
astronomical community, because we so far lack the means to conclusively test
one theory against the other.
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TIP
You can see the galaxy clusters that Professor Zwicky studied to discover Dark
Matter. Use the KStars Find Object Window (Ctrl+F) to center on ‘M 87’ to find the
Virgo Cluster, and on ‘NGC 4884’ to find the Coma Cluster. You may have to zoom
in to see the galaxies. Note that the Virgo Cluster appears to be much larger on
the sky. In reality, Coma is the larger cluster; it only appears smaller because it is
further away.

5.22 Flux

The flux is the amount of energy that passes through a unit area each second.

Astronomers use flux to denote the apparent brightness of a celestial body.
The apparent brightness is defined as the the amount of light received from
a star above the earth atmosphere passing through a unit area each second.
Therefore, the apparent brightness is simply the flux we receive from a star.

The flux measures the rate of flow of energy that passes through each cmˆ2 (or
any unit area) of an object’s surface each second. The detected flux depends
on the distance from the source that radiates the energy. This is because the
energy has to spread over a volume of space before it reaches us. Let us as-
sume that we have an imaginary balloon that encloses a star. Each dot on the
balloon represents a unit of energy emitted from the star. Initially, the dots in
an area of one cmˆ2 are in close proximity to each other and the flux (energy
emitted per square centimeter per second) is high. After a distance d, the vol-
ume and surface area of the balloon increased causing the dots to spread away
from each. Consequently, the number of dots (or energy) enclosed in one cmˆ2
has decreased as illustrated in Figure 1.
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Figure 1

The flux is inversely proportional to distance by a simple rˆ2 relation. There-
fore, if the distance is doubled, we receive 1/2ˆ2 or 1/4th of the original flux.
From a fundamental standpoint, the flux is the luminosity per unit area:

where (4 * PI * Rˆ2) is the surface area of a sphere (or a balloon!) with a radius
R. Flux is measured in Watts/mˆ2/s or as commonly used by astronomers:
Ergs/cmˆ2/s. For example, the luminosity of the sun is L = 3.90 * 10ˆ26 W.
That is, in one second the sun radiates 3.90 * 10ˆ26 joules of energy into space.
Thus, the flux we receive passing through one square centimeter from the sun
at a distance of one AU (1.496 * 10ˆ13 cm) is:

5.23 Luminosity

Luminosity is the amount of energy emitted by a star each second.
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All stars radiate light over a broad range of frequencies in the electromagnetic
spectrum from the low energy radio waves up to the highly energetic gamma
rays. A star that emits predominately in the ultra-violet region of the spectrum
produces a total amount of energy magnitudes larger than that produced in a
star that emits principally in the infrared. Therefore, luminosity is a measure
of energy emitted by a star over all wavelengths. The relationship between
wavelength and energy was quantified by Einstein as E = h * v where v is the
frequency, h is the Planck constant, and E is the photon energy in joules. That
is, shorter wavelengths (and thus higher frequencies) correspond to higher en-
ergies.

For example, a wavelength of lambda = 10 meter lies in the radio region of the
electromagnetic spectrum and has a frequency of f = c / lambda = 3 * 10ˆ8 m/s
/ 10 = 30 MHz where c is the speed of light. The energy of this photon is E = h *
v = 6.625 * 10ˆ-34 J s * 30 Mhz = 1.988 * 10ˆ-26 joules. On the other hand, visible
light has much shorter wavelengths and higher frequencies. A photon that has
a wavelength of lambda = 5 * 10ˆ-9 meters (A greenish photon) has an energy
E = 3.975 * 10ˆ-17 joules which is over a billion times higher than the energy of
a radio photon. Similarly, a photon of red light (wavelength lambda = 700 nm)
has less energy than a photon of violet light (wavelength lambda = 400 nm).

Luminosity depends both on temperature and surface area. This makes sense
because a burning log radiates more energy than a match, even though both
have the same temperature. Similarly, an iron rod heated to 2000 degrees emits
more energy than when it is heated to only 200 degrees.

Luminosity is a very fundamental quantity in Astronomy and Astrophysics.
Much of what is learnt about celestial objects comes from analyzing their light.
This is because the physical processes that occur inside stars gets recorded and
transmitted by light. Luminosity is measured in units of energy per second.
Astronomers prefer to use Ergs, rather than Watts, when quantifying luminos-
ity.

5.24 Parallax

Parallax is the apparent change of an observed object’s position caused by a
shift in the observer’s position. As an example, hold your hand in front of you
at arm’s length, and observe an object on the other side of the room behind your
hand. Now tilt your head to your right shoulder, and your hand will appear
on the left side of the distant object. Tilt your head to your left shoulder, and
your hand will appear to shift to the right side of the distant object.

Because the Earth is in orbit around the Sun, we observe the sky from a con-
stantly moving position in space. Therefore, we should expect to see an annual
parallax effect, in which the positions of nearby objects appear to ‘wobble’ back
and forth in response to our motion around the Sun. This does in fact happen,
but the distances to even the nearest stars are so great that you need to make
careful observations with a telescope to detect it2.

2The ancient Greek astronomers knew about parallax; because they could not observe an annual
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Modern telescopes allow astronomers to use the annual parallax to measure
the distance to nearby stars, using triangulation. The astronomer carefully
measures the position of the star on two dates, spaced six months apart. The
nearer the star is to the Sun, the larger the apparent shift in its position will be
between the two dates.
Over the six-month period, the Earth has moved through half its orbit around
the Sun; in this time its position has changed by 2 Astronomical Units (abbrevi-
ated AU; 1 AU is the distance from the Earth to the Sun, or about 150 million
kilometers). This sounds like a really long distance, but even the nearest star
to the Sun (alpha Centauri) is about 40 trillion kilometers away. Therefore, the
annual parallax is very small, typically smaller than one arcsecond, which is
only 1/3600 of one degree. A convenient distance unit for nearby stars is the
parsec, which is short for "parallax arcsecond". One parsec is the distance a star
would have if its observed parallax angle was one arcsecond. It is equal to 3.26
light-years, or 31 trillion kilometers3.

5.25 Retrograde Motion

Retrograde Motion is the orbital motion of a body in a direction opposite that
which is normal to spatial bodies within a given system.

When we observe the sky, we expect most objects to appear to move in a par-
ticular direction with the passing of time. The apparent motion of most bodies
in the sky is from east to west. However it is possible to observe a body mov-
ing west to east, such as an artificial satellite or space shuttle that is orbiting
eastward. This orbit is considered Retrograde Motion.

Retrograde Motion is most often used in reference to the motion of the outer
planets (Mars, Jupiter, Saturn, and so forth). Though these planets appear
to move from east to west on a nightly basis in response to the spin of the
Earth, they are actually drifting slowly eastward with respect to the stationary
stars, which can be observed by noting the position of these planets for sev-
eral nights in a row. This motion is normal for these planets, however, and not
considered Retrograde Motion. However, since the Earth completes its orbit in
a shorter period of time than these outer planets, we occasionally overtake an
outer planet, like a faster car on a multiple-lane highway. When this occurs, the
planet we are passing will first appear to stop its eastward drift, and it will then
appear to drift back toward the west. This is Retrograde Motion, since it is in a
direction opposite that which is typical for planets. Finally, as the Earth swings
past the the planet in its orbit, they appear to resume their normal west-to-east
drift on successive nights.

parallax in the positions of stars, they concluded that the Earth could not be in motion around the
Sun. What they did not realize was that the stars are millions of times further away than the Sun,
so the parallax effect is impossible to see with the unaided eye.

3Astronomers like this unit so much that they now use ‘kiloparsecs’ to measure galaxy-scale
distances, and ‘Megaparsecs’ to measure intergalactic distances, even though these distances are
much too large to have an actual, observable parallax. Other methods are required to determine
these distances
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This Retrograde Motion of the planets puzzled ancient Greek astronomers, and
was one reason why they named these bodies ‘planets’ which in Greek means
‘wanderers’.

5.26 Elliptical Galaxies

Elliptical galaxies are spheroidal concentrations of billions of stars that resem-
ble Globular Clusters on a grand scale. They have very little internal struc-
ture; the density of stars declines smoothly from the concentrated center to
the diffuse edge, and they can have a broad range of ellipticities (or aspect ra-
tios). They typically contain very little interstellar gas and dust, and no young
stellar populations (although there are exceptions to these rules). Edwin Hub-
ble referred to Elliptical galaxies as ‘early-type’ galaxies, because he thought
that they evolved to become Spiral Galaxies (which he called ‘late-type’ galax-
ies). Astronomers actually now believe the opposite is the case (i.e., that Spiral
galaxies can turn into Elliptical galaxies), but Hubble’s early- and late-type la-
bels are still used.
Once thought to be a simple galaxy type, ellipticals are now known to be quite
complex objects. Part of this complexity is due to their amazing history: ellipti-
cals are thought to be the end product of the merger of two Spiral galaxies. You
can view a computer simulation MPEG movie of such a merger at this NASA
HST webpage (warning: the file is 3.4 MB).

Elliptical galaxies span a very wide range of sizes and luminosities, from giant
Ellipticals hundreds of thousands of light years across and nearly a trillion
times brighter than the sun, to dwarf Ellipticals just a bit brighter than the
average globular cluster. They are divided to several morphological classes:

cD galaxies: Immense and bright objects that can measure nearly 1 Megaparsec
(3 million light years) across. These titans are only found near the cen-
ters of large, dense clusters of galaxies, and are likely the result of many
galaxy mergers.

Normal Elliptical galaxies Condensed Object with relatively high central sur-
face brightness. They include the giant ellipticals (gE’e), intermediate-
luminosity ellipticals (E’s), and compact ellipticals.

Dwarf elliptical galaxies (dE’s) This class of galaxies is fundamentally differ-
ent from normal ellipticals. Their diameters on the order of 1 to 10 kilo-
parsec with surface brightness that is much lower than normal ellipticals,
giving them a much more diffuse appearance. They display the same
characteristic gradual decline of star density from a relatively dense core
out to a diffuse periphery.

Dwarf spheroidal galaxies (dSph’s) Extreme low-luminosity, low surface-brightness
and have only been observed in the vicinity of the Milky Way, and pos-
sibly other very nearby galaxy groups, such as the Leo group. Their ab-
solute magnitudes are only -8 to -15 mag. The Draco dwarf spheroidal
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galaxy has an absolute magnitude of -8.6, making it fainter than the av-
erage globular cluster in the Milky Way!

Blue compact dwarf galaxies (BCD’s) Small galaxies that are unusually blue.
Thehave photometric colors of B-V = 0.0 to 0.30 mag, which is typical
for relatively young stars of spectral type A. This suggests that BCDs are
currently actively forming stars. These systems also have abundant in-
terstellar gas (unlike other Elliptical galaxies).

TIP
You can see examples of Elliptical galaxies in KStars, using the Find Object window
(Ctrl+F). Search for NGC 4881, which is the Giant cD galaxy in the Coma cluster
of galaxies. M 86 is a normal Elliptical galaxy in the Virgo cluster of galaxies. M
32 is a dwarf Elliptical that is a satellite of our neighbor, the Andromeda galaxy (M
31). M 110 is another satellite of M 31 that is a borderline dwarf spheroidal galaxy
(‘borderline’ because it is somewhat brighter than most other dwarf spheroidals).

5.27 Spiral Galaxies

Spiral galaxies are huge collections of billions of stars, most of which are flat-
tened into a disk shape, with a bright, spherical bulge of stars at its center.
Within the disk, there are typically bright arms where the youngest, brightest
stars are found. These arms wind out from the center in a spiral pattern, giving
the galaxies their name. Spiral galaxies look a bit like hurricanes, or like water
flowing down a drain. They are some of the most beautiful objects in the sky.

Galaxies are classified using a ‘tuning fork diagram’. The end of the fork clas-
sifies elliptical galaxies on a scale from the roundest, which is an E0, to those
that appear most flattened, which is rated as E7. The ‘tines’ of the tuning fork
are where the two types of spiral galaxies are classified: normal spirals, and
‘barred’ spirals. A barred spiral is one whose nuclear bulge is stretched out
into a line, so it literally looks like it has a ‘bar’ of stars in its center.

Both types of spiral galaxies are sub-classified according to the prominence of
their central ‘bulge’ of stars, their overall surface brightness, and how tightly
their spiral arms are wound. These characteristics are related, so that an Sa
galaxy has a large central bulge, a high surface brightness, and tightly-wound
spiral arms. An Sb galaxy has a smaller bulge, a dimmer disk, and looser
arms than an Sa, and so on through Sc and Sd. Barred galaxies use the same
classification scheme, indicated by types SBa, SBb, SBc, and SBd.

There is another class of galaxy called S0, which is morphologically a tran-
sitional type between true spirals and ellipticals. Its spiral arms are so tightly
wound as to be indistinguishable; S0 galaxies have disks with a uniform bright-
ness. They also have an extremely dominant bulge.

The Milky Way galaxy, which is home to earth and all of the stars in our sky,
is a Spiral Galaxy, and is believed to be a barred spiral. The name ‘Milky Way’
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refers to a band of very faint stars in the sky. This band is the result of looking
in the plane of our galaxy’s disk from our perspective inside it.

Spiral galaxies are very dynamic entities. They are hotbeds of star formation,
and contain many young stars in their disks. Their central bulges tend to be
made of older stars, and their diffuse halos are made of the very oldest stars in
the Universe. Star formation is active in the disks because that is where the gas
and dust are most concentrated; gas and dust are the building blocks of star
formation.
Modern telescopes have revealed that many Spiral galaxies harbor supermas-
sive black holes at their centers, with masses that can exceed that of a billion
Suns. Both elliptical and spiral galaxies are known to contain these exotic ob-
jects; in fact many astronomers now believe that all large galaxies contain a
supermassive black hole in their nucleus. Our own Milky Way is known to
harbor a black hole in its core with a mass millions of times bigger than a star’s
mass.

TIP
There are many fine examples of spiral galaxies to be found in KStars, and many
have beautiful images available in their popup menu. You can find them by using
the Find Object window. Here is a list of some spiral galaxies with nice images
available:

• M 64, the Black-Eye Galaxy (type Sa)

• M 31, the Andromeda Galaxy (type Sb)

• M 81, Bode’s Galaxy (type Sb)

• M 51, the Whirlpool Galaxy (type Sc)

• NGC 300 (type Sd) [use DSS image link]

• M 83 (type SBa)

• NGC 1530 (type SBb)

• NGC 1073 (type SBc)

5.28 Magnitude Scale

2500 years ago, the ancient Greek astronomer Hipparchus classified the bright-
nesses of visible stars in the sky on a scale from 1 to 6. He called the very
brightest stars in the sky ‘first magnitude’, and the very faintest stars he could
see ‘sixth magnitude’. Amazingly, two and a half millenia later, Hipparchus’s
classification scheme is still widely used by astronomers, although it has since
been modernized and quantified.
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NOTE
The magnitude scale runs backwards to what you might expect: brighter stars have
smaller magnitudes than fainter stars).

The modern magnitude scale is a quantitative measurement of the flux of light
coming from a star, with a logarithmic scaling:

m = m_0 - 2.5 log (F / F_0)

If you do not understand the math, this just says that the magnitude of a given
star (m) is different from that of some standard star (m_0) by 2.5 times the log-
arithm of their flux ratio. The 2.5 *log factor means that if the flux ratio is 100,
the difference in magnitudes is 5 mag. So, a 6th magnitude star is 100 times
fainter than a 1st magnitude star. The reason Hipparchus’s simple classifica-
tion translates to a relatively complex function is that the human eye responds
logarithmically to light.

There are several different magnitude scales in use, each of which serves a
different purpose. The most common is the apparent magnitude scale; this
is just the measure of how bright stars (and other objects) look to the human
eye. The apparent magnitude scale defines the star Vega to have magnitude
0.0, and assigns magnitudes to all other objects using the above equation, and
a measure of the flux ratio of each object to Vega.

It is difficult to understand stars using just the apparent magnitudes. Imagine
two stars in the sky with the same apparent magnitude, so they appear to be
equally bright. You cannot know just by looking if the two have the same in-
trinsic brightness; it is possible that one star is intrinsically brighter, but further
away. If we knew the distances to the stars (see the parallax article), we could
account for their distances and assign Absolute magnitudes which would reflect
their true, intrinsic brightness. The absolute magnitude is defined as the appar-
ent magnitude the star would have if observed from a distance of 10 parsecs (1
parsec is 3.26 light-years, or 3.1 x 10ˆ18 cm). The absolute magnitude (M) can
be determined from the apparent magnitude (m) and the distance in parsecs
(d) using the formula:

M = m + 5 - 5 * log(d) (note that M=m when d=10).

The modern magnitude scale is no longer based on the human eye; it is based
on photographic plates and photoelectric photometers. With telescopes, we
can see objects much fainter than Hipparchus could see with his unaided eyes,
so the magnitude scale has been extended beyond 6th magnitude. In fact, the
Hubble Space Telescope can image stars nearly as faint as 30th magnitude,
which is one trillion times fainter than Vega.

A final note: the magnitude is usually measured through a color filter of some
kind, and these magnitudes are denoted by a subscript describing the filter (i.e.,
m_V is the magnitude through a ‘visual’ filter, which is greenish; m_B is the
magnitude through a blue filter; m_pg is the photographic plate magnitude,
etc.).
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5.29 Stars: An Introductory FAQ

1. What are the stars?
Stars are gigantic, self-gravitating spheres of (mostly) Hydrogen gas. Stars
are also thermonuclear engines; nuclear fusion takes place deep in the
cores of stars, where the density is extreme and the temperature reaches
tens of millions of degrees Celsius.

2. Is the Sun a star?
Yes, the Sun is a star. It is the dominant centerpiece of our solar system.
Compared to other stars, our Sun is rather ordinary; it appears to be so
much bigger and brighter to us because it is millions of times closer than
any other star.

3. Why do stars shine?
The short answer is: star shine because they are very hot. It is really no
more complicated than that. Any object heated to thousands of degrees
will radiate light, just like stars do.

4. The obvious next question is: why are stars so hot?
This is a tougher question. The usual answer is that stars get their heat
from the thermonuclear fusion reactions in their cores. However, this
cannot be the ultimate cause for the stars’ heat, because a star must be
hot in the first place for nuclear fusion to be triggered. Fusion can only
sustain the hot temperature; it cannot make a star hot. A more correct
answer is that stars are hot because they have collapsed. Stars form from
diffuse gaseous nebulae; as the nebulous gas condenses to form a star, the
gravitational potential energy of the material is released, first as kinetic
energy, and ultimately as heat as the density increases.

5. Are stars all the same?
Stars have many things in common: they are all collapsed spheres of hot,
dense gas (mostly Hydrogen), and nuclear fusion reactions are occurring
at or near the centers of every star in the sky. However, stars also show
a great diversity in some properties. The brightest stars shine almost
100 million times as brightly as the faintest stars. Stars range in surface
temperature from only a few thousand degrees to almost 50,000 degrees
Celsius. These differences are largely due to differences in mass: massive
stars are both hotter and brighter than lower-mass stars. The temperature
and Luminosity also depend on the evolutionary state of the star.

6. What is the Main Sequence?
The main sequence is the evolutionary state of a star when it is fusing
Hydrogen in its core. This is the first (and longest) stage of a star’s life
(not including protostar phases). What happens to a star after it runs
out of core Hydrogen is addressed in the stellar evolution article (coming
soon).
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7. How long do stars last?
The lifetime of a star depends very much on its mass. More massive
stars are hotter and shine much more brightly, causing them to consume
their nuclear fuel much more rapidly. The largest stars (roughly 100 times
as massive as the Sun), will run out of fuel in only a few million years;
while the smallest stars (roughly ten percent the mass of the Sun), with
their much more frugal consumption rate, will shine on (albeit dimly) for
trillions of years. Note that this is much longer than the Universe has yet
been in existence.

5.30 Star Colors and Temperatures

Stars appear to be exclusively white at first glance. But if we look carefully,
we can notice a range of colors: blue, white, red, and even gold. In the winter
constellation of Orion, a beautiful contrast is seen between the red Betelgeuse
at Orion’s "armpit" and the blue Bellatrix at the shoulder. What causes stars
to exhibit different colors remained a mystery until two centuries ago, when
Physicists gained enough understanding of the nature of light and the proper-
ties of matter at immensely high temperatures.

Specifically, it was the physics of blackbody radiation that enabled us to un-
derstand the variation of stellar colors. Shortly after blackbody radiation was
understood, it was noticed that the spectra of stars look extremely similar to
blackbody radiation curves of various temperatures, ranging from a few thou-
sand Kelvin to 50,000 Kelvin. The obvious conclusion is that stars are similar
to blackbodies, and that the color variation of stars is a direct consequence of
their surface temperatures.

Cool stars (i.e., Spectral Type K and M) radiate most of their energy in the
red and infrared region of the electromagnetic spectrum and thus appear red,
while hot stars (i.e., Spectral Type O and B) emit mostly at blue and ultra-violet
wavelengths, making them appear blue or white.

To estimate the surface temperature of a star, we can use the known relation-
ship between the temperature of a blackbody, and the wavelength of light
where its spectrum peaks. That is, as you increase the temperature of a black-
body, the peak of its spectrum moves to shorter (bluer) wavelengths of light.
This is illustrated in Figure 1 where the intensity of three hypothetical stars is
plotted against wavelength. The "rainbow" indicates the range of wavelengths
that are visible to the human eye.
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Figure 1

This simple method is conceptually correct, but it cannot be used to obtain
stellar temperatures accurately, because stars are not perfect blackbodies. The
presence of various elements in the star’s atmosphere will cause certain wave-
lengths of light to be absorbed. Because these absorption lines are not uni-
formly distributed over the spectrum, they can skew the position of the spec-
tral peak. Moreover, obtaining a usable spectrum of a star is a time-intensive
process and is prohibitively inefficient for large samples of stars.

An alternative method utilizes photometry to measure the intensity of light
passing through different filters. Each filter allows only a specific part of the
spectrum of light to pass through while rejecting all others. A widely used
photometric system is called the Johnson UBV system. It employs three band-
pass filters: U ("Ultra-violet"), B ("Blue"), and V ("Visible"); each occupying
different regions of the electromagnetic spectrum.

The process of UBV photometry involves using light sensitive devices (such as
film or CCD cameras) and aiming a telescope at a star to measure the intensity
of light that passes through each of the filters individually. This procedure
gives three apparent brightnesses or fluxes (amount of energy per cmˆ2 per
second) designated by Fu, Fb, and Fv. The ratio of fluxes Fu/Fb and Fb/Fv
is a quantitative measure of the star’s "color", and these ratios can be used
to establish a temperature scale for stars. Generally speaking, the larger the
Fu/Fb and Fb/Fv ratios of a star, the hotter its surface temperature.

For example, the star Bellatrix in Orion has Fb/Fv = 1.22, indicating that it is
brighter through the B filter than through the V filter. furthermore, its Fu/Fb
ratio is 2.22, so it is brightest through the U filter. This indicates that the star
must be very hot indeed, since the position of its spectral peak must be some-
where in the range of the U filter, or at an even shorter wavelength. The sur-
face temperature of Bellatrix (as determined from comparing its spectrum to
detailed models that account for its absorption lines) is about 25,000 Kelvin.
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We can repeat this analysis for the star Betelgeuse. Its Fb/Fv and Fu/Fb ratios
are 0.15 and 0.18, respectively, so it is brightest in V and dimmest in U. So, the
spectral peak of Betelgeuse must be somewhere in the range of the V filter, or
at an even longer wavelength. The surface temperature of Betelgeuse is only
2,400 Kelvin.
Astronomers prefer to express star colors in terms of a difference in magni-
tudes, rather than a ratio of fluxes. Therefore, going back to blue Bellatrix we
have a color index equal to

B - V = -2.5 log (Fb/Fv) = -2.5 log (1.22) = -0.22,

Similarly, the color index for red Betelgeuse is

B - V = -2.5 log (Fb/Fv) = -2.5 log (0.18) = 1.85

The color indices, like the magnitude scale, run backward. Hot and blue stars
have smaller and negative values of B-V than the cooler and redder stars.

An Astronomer can then use the color indices for a star, after correcting for
reddening and interstellar extinction, to obtain an accurate temperature of that
star. The relationship between B-V and temperature is illustrated in Figure 2.

Figure 2

The Sun with surface temperature of 5,800 K has a B-V index of 0.62.
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Chapter 6

KStars Tools

KStars comes with a number of tools that allow you to explore some more
advanced aspects of astronomy and the night sky.

• Object Details

• Astrocalculator

• AAVSO Lightcurves

• Altitude vs. Time Plotter

• What’s Up Tonight?

• Script Builder

• Solar System Viewer

• Jupiter Moons Tool

• Observing List Tool

• FITS Viewer
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6.1 Object Details Window

The Object Details Window presents advanced data available about a specific
object in the sky. To access this tool, right-click on any object, and select the
Details... item from the popup menu.

The window is divided into a number of Tabs. In the General Tab, we present
basic data about the current object. This includes names and catalog desig-
nations, object type, and magnitude (brightness). Also shown are the object’s
Equatorial and Horizontal coordinates, as well as its rise, set and transit times.

In the Links tab, you can manage the internet links associated with this object.
The Image and Information links associated with the object are listed. These
are the links that appear in the popup menu when the object is right-clicked.
You can add custom links to the object with the Add Link... button. This will
open a window in which you fill in the URL and link text for the new link (you
can also test the URL in the web browser from this window). Keep in mind
that the custom link can easily point to a file on your local disk, so you can use
this feature to index your personal astronomical images or observing logs.
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You can also modify or remove any link using the Edit Link... and Remove
Link... buttons.
The Advanced Tab allows you to query professional astronomical databases on
the internet for information regarding the current object. To use these databases,
simply highlight the desired database in the list, and press the View button to
see the results of your query in a web browser window. The query is made us-
ing the primary name of the object you clicked on to open the Details Dialog.
The following databases are available for querying:

• High Energy Astrophysical Archive (HEASARC). Here you can retrieve data
about the current object from a number of ‘High-energy’ observatories, which
covers the Ultraviolet, X-ray and Gamma Ray portions of the electromag-
netic spectrum.

• Multimission Archive at Space Telescope (MAST). The Space Telescope Sci-
ence Institute provides access to the entire collection of images and spectra
taken with the Hubble Space Telescope, as well as several other space-based
observatories.

• NASA Astrophysical Data System (ADS). This incredible bibliographic database
encompass the entire body of literature published in international peer-review
Journals about astronomy and astrophysics. The database is divided into
four general subject areas (Astronomy and Astrophysics, Astrophysics Preprints,
Instrumentation, and Physics and Geophysics). Each of these has three sub-
nodes that query the database in different ways. ‘Keyword search’ will re-
turn articles which listed the object’s name as a keyword. ‘Title word search’
will return articles which included the object name in their Title, and the
‘Title & Keyword search’ uses both options together.

• NASA/IPAC Extragalactic Database (NED). NED provides encapsulated data
and bibliographic links about extragalactic objects. You should only use
NED if your target is extragalactic; i.e. if it is itself a galaxy.

• Set of Identifications, Measurements, and Bibliography for Astronomical Data
(SIMBAD). SIMBAD is similar to NED, except it provides data about all
kinds of objects, not just galaxies.

• SkyView provides images from All-Sky surveys that have been performed
in dozens of different parts of the spectrum, from Gamma Rays to the Ra-
dio. The KStars interface will retrieve an image from any of these surveys,
centered on the selected object.

Finally, in the Log Tab, you can type in some text that will remain associated
with this object’s Details window. You could use this to attach personal observ-
ing notes, for example.

6.2 The Astrocalculator

The KStars Astrocalculator provides several modules that give you direct ac-
cess to algorithms used by the program. The modules are organized by subject:
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COORDINATE CONVERTERS

• Angular Distance

• Apparent Coordinates

• Ecliptic Coordinates

• Equatorial/Galactic Coordinates

• Horizontal Coordinates

• Precession

EARTH COORDINATES

• Geodetic Coordinates

SOLAR SYSTEM

• Planets Coordinates

TIME CALCULATORS

• Day Duration

• Equinoxes and Solstices

• Julian Day

• Sidereal Time
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6.2.1 Angular Distance module

The Angular Distance tool is used to measure the angle between any two points
on the sky. You simply specify the Equatorial coordinates of the desired pair
of points, and then press the Compute button to obtain the angle between the
two points.

There is also a Batch mode for this module. In batch mode, you specify an
input filename which contains four numbers per line: the RA and Dec values
for pairs of points. Alternatively, you can specify a single value for any of these
four coordinates in the calculator panel (the corresponding values in the input
file should be skipped if they are specified in the calculator).

Once you have specified the input filename and an output filename, simply
press the Run button to generate the output file.
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6.2.2 Apparent Coordinates module

The Apparent Coordinates module converts the catalog coordinates of a point in
the sky to its apparent coordinates for any date. The coordinates of objects in the
sky are not fixed, because of precession, nutation and aberration. This module
takes these effects into account.
To use the module, first enter the desired target date and time in the Target
Time/Date section. Then, enter the catalog coordinates in the Catalog Coordi-
nates section. You can also specify the catalog’s epoch here (usually 2000.0 for
modern object catalogs). Finally, press the Compute button, and the object’s
coordinates for the target date will be displayed in the Apparent Coordinates
section.
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6.2.3 Ecliptic Coordinates module

This module converts between Equatorial coordinates and Ecliptic coordinates.
First, select which coordinates should be taken as input values in the Choose
Input Coordinates section. Then, fill in the corresponding coordinate values in
either the Ecliptic coordinates or Equatorial coordinates section. Finally, press
the Compute button, and the complementary coordinates will be filled in.

The module contains a batch mode for converting several coordinate pairs at
once. You must construct an input file in which each line contains two val-
ues: the input coordinate pairs (either Equatorial or Ecliptic). Then specify
which coordinates you are using as input, and identify the input and output
filenames. Finally, press the Run button to generate the output file, which will
contain the converted coordinates (Equatorial or Ecliptic; the complement of
what you chose as the input values).
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6.2.4 Equatorial/Galactic Coordinates module

This module converts from Equatorial coordinates to Galactic coordinates, and
vice versa. First, select which coordinates should be taken as input values in
the Input Selection section. Then, fill in the corresponding coordinate values in
either the Galactic coordinates or Equatorial coordinates section. Finally, press
the Compute button, and the complementary coordinates will be filled in.

62



The KStars Handbook

6.2.5 Horizontal Coordinates module

This module converts from Equatorial coordinates to Horizontal coordinates.
First, select the date, time, and geographic coordinates for the calculation in the
Input Data section. Then, fill in the equatorial coordinates to be converted and
their catalog epoch in the Equatorial Coordinates section. When you press the
Compute button, the corresponding Horizontal coordinates will be presented
in the Horizontal Coordinates section.
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6.2.6 Precession module

This module is similar to the Apparent Coordinates module, but it only applies
the effect of precession, not of nutation or aberration.

To use the module, first enter the input coordinates and their epoch in the Orig-
inal Coordinates section. You must also fill in the target epoch in the Precessed
Coordinates section. Then, press the Compute button, and the object’s coor-
dinates, precessed to the target Epoch, are presented in the Precessed Coordi-
nates section.
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6.2.7 Geodetic Coordinates module

The normal geographic coordinate system assumes that the Earth is a perfect
sphere. This is nearly true, so for most purposes geographic coordinates are
fine. If very high precision is required, then we must take the true shape of the
Earth into account. The Earth is an ellipsoid; the distance around the equator is
about 0.3% longer than a Great Circle that passes through the poles. The Geode-
tic Coordinate system takes this ellipsoidal shape into account, and expresses the
position on the Earth’s surface in Cartesian coordinates (X, Y, and Z).

To use the module, first select which coordinates you will use as input in the In-
put Selection section. Then, fill in the input coordinates in either the Cartesian
Coordinates section or the Geographic Coordinates section. When you press
the Compute button, the corresponding coordinates will be filled in.
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6.2.8 Planet Coordinates module

The Planet Coordinates module computes positional data for any major solar
system body, for any time and date and any geographic location. Simply se-
lect the solar system body from the drop-down list, and specify the desired
date, time, and geographic coordinates (these values are preset to the current
KStars settings). Then press the Compute button to determine the Equatorial,
Horizontal, and Ecliptic coordinates of the body.

There is a batch mode for this module. You must construct an input file in
which each line specifies values for the input parameters (solar system body,
date, time, longitude, and latitude). You may choose to specify a constant value
for some of the parameters in the calculator window (these parameters should
be skipped in the input file). You may also specify which of the output param-
eters (Equatorial, Horizontal, and Ecliptic coordinates) should be calculated.
Finally, specify the input and output filenames, and press the Run button to
generate the output file with the computed values.
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6.2.9 Day Duration module

This module computes the length of day as well as sunrise, sun-transit (noon),
and sunset times for any calendar date, for any location on Earth. First fill in
the desired geographic coordinates and date, then press the Compute button.
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6.2.10 Equinoxes and Solstices module

The Equinoxes and Solstices module calculates the date and time of an equinox
or solstice for a given year. You specify which event (Spring Equinox, Summer
Solstice, Autumn Equinox, or Winter Solstice) should be investigated, and the
year. Then press the Compute button to obtain the date and time of the event,
and the length of the corresponding season, in days.

There is a batch mode for this module. To use it, simply generate an input file
whose lines each contain a year for which the Equinox and Solstice data will
be computed. Then specify the input and output filenames, and press the Run
button to generate the output file. Each line in the output file contains the input
year, the date and time of each event, and the length of each season.
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6.2.11 Julian Day module

This module converts between the calendar date, the Julian Day, and the Mod-
ified Julian Day. The Modified Julian Day is simply equal to the Julian Day -
2,400,000.5.

To use the module, select which of the three dates will be the input, and then
fill in its value. Then press the Compute button, and the corresponding values
for the other two date systems will be displayed.

TIP
Exercise:
What calendar date does MJD = 0.0 correspond to?
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6.2.12 Sidereal Time module

This module converts between Universal Time and Local Sidereal Time. First,
select whether you will use Universal Time or Sidereal Time as an input value
in the Input Selection section. You must also specify a geographic longitude,
and a date for the calculation, in addition to either the Universal Time or the
Sidereal Time value. When you press the Compute button, the corresponding
value for the other Time will be displayed.
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6.3 AAVSO Light Curves

6.3.1 Introduction

KStars can display light curves for variable stars from the observing program
of the American Association of Variable Star Observers (AAVSO). This pro-
gram monitors over 6,000 variable stars and consists of 10 million observations
going back almost a century. KStars downloads the very latest data directly
from the AAVSO database via the Internet, so a network connection is required
to use this tool.
To use the tool, select a variable star either by designation or name in the left
panel, and set the start and end dates to be plotted. In the right panel, select
the type of data that should be plotted (see below). When you have made you
selections, press the Retrieve Curve button. KStars will automatically connect
to the AAVSO server, which will generate the lightcurve plot and send it to
your computer for display. A sample lightcurve plot is shown below:
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Please not these light curves should NEVER be used in research, papers, pre-
sentations, publications, etc.. They are only meant to be used as a source of
info for KStars. They have not been validated and passed the AAVSO’s strict
quality control measures. We will be glad to give you good raw data simply by
requesting it at http://www.aavso.org/adata/onlinedata/ .

Specific questions about the data in the light curves can be sent to aavso@aavso.org.

6.3.2 About Variable Stars

Variable stars are stars that change in brightness. A light curve is a plot of a
variable star’s brightness over time. By looking at a light curve you can see
how the star has behaved in the past and try to predict how it will behave in
the future. Astronomers also use this data to model astrophysical processes in
the star. This important to help us understand how stars work.

72

http://www.aavso.org/adata/onlinedata/
mailto:aavso@aavso.org


The KStars Handbook

6.3.3 The Data

Here is a summary of the various types of data available in the light curves:

• Visual Observation: This is an observation of a variable star by an observer
with a regular telescope. It means that an observer saw the star at Y bright-
ness on X date and time.

• Fainter than: Sometimes the star is too faint to be seen by the observer. When
that happens, the observer reports the faintest star seen in the field. These are
called ‘fainter thans’ because the variable star was fainter than the brightness
reported.

• Average: This is a computed running average of all the data reported. The
bin number tells the computer how many days to use in each average calcu-
lation. This will need to be adjusted based on the frequency of observations.
The error bars represent the 1 sigma standard deviation of error.

• CCDV: These are observations reported using a CCD with a Johnson V filter.
CCDV observations tend to be more accurate than visual (but not always).

• CCDB: CCD observations with a Johnson B filter.

• CCDI: CCD observations with a Cousins Ic filter.

• CCDR: CCD observations with a Cousins R filter.

• Discrepant Data: This is data that has been flagged by an AAVSO staff mem-
ber as being discrepant following HQ rules for data validation. Contact
aavso@aavso.org for more information.

• Dates: The observational database the light curves are based on is updated
every 10 minutes so you can get data in near real-time. Right now light curve
data is only available back to 1961, but this will likely be expanded further
back in time in the future.

6.3.4 Updating your local copy of Variable Stars

The AAVSO publishes the full list of variable stars in their monitoring program.
This file is updated monthly with newly discovered variable stars. To sync
the list that KStars uses with the AAVSO master list, click on the Update List
button in the AAVSO dialog. KStars will then attempt to connect to the AAVSO
database and download the latest list.

NOTE
The customized data stream provided by the AAVSO was implemented for KStars
by Aaron Price. Thank you, Aaron!
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6.4 Altitude vs. Time Tool

This tool plots the altitude of any objects as a function of time, for any date
and location on Earth. The top section is a graphical plot of altitude angle on
the vertical axis, and time on the horizontal axis. The time is shown both as
standard local time along the bottom, and sidereal time along the top. The
bottom half of the graph is shaded green to indicate that points in this region
are below the horizon.
There are a few ways to add curves to the plot. The simplest way to add the
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curve of an existing object is to simply type its name in the Name input field,
and press Enter, or the Plot button. If the text you enter is found in the ob-
ject database, the object’s curve is added to the graph. You can also press the
Browse button to open the Find Object Window to select an object from the list
of known objects. If you want to add a point that does not exist in the object
database, simply enter a name for the point, and then fill in the coordinates in
the RA and Dec input fields. Then press the Plot button to add the curve for
your custom object to the plot (note that you have to pick a name that does not
already exist in the object database for this to work).

When you add an object to the plot, its altitude vs. time curve is plotted with
a thick white line, and its name is added to the listbox at the lower right. Any
objects that were already present are plotted with a thinner red curve. You can
choose which object is plotted with the thick white curve by highlighting its
name in the listbox.
These curves show the objects’ Altitude (angle above the horizon) as a function
of time. When a curve passes from the lower half to the upper half, the object
has risen; when it falls back to the lower half, it has set. For example, in the
screenshot, the minor planet Quaoar is setting at around 15:00 local time, and is
rising at about 04:00 local time.

The Altitude of an object depends on both where you are on Earth, and on
the Date. By default, the Tool adopts the Location and Date from the current
KStars settings. You can change these parameters in the Date & Location Tab.
To change the Location, you can press the Choose City... button to open the Set
Geographic Location Window, or enter Longitude and Latitude values manu-
ally in the input fields, and press the Update button. To change the Date, use
the Date picker widget, then press Update. Note that any curves you had al-
ready plotted will be automatically updated when you change the Date and/or
Location.

TIP
Exercise:
Plot the Sun’s Altitude curve. Make sure the geographic location is not near the
equator. Change the Date to some time in June, and then again to sometime in
January. You can see easily why we have seasons; in the winter, the Sun is above
the horizon for less time (the days are shorter), and its altitude is never very high.
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6.5 What’s Up Tonight? Tool

The ‘What’s Up Tonight?’ (WUT) tool displays a list of objects that will be vis-
ible at night from any location, on any date. By default, the Date and Location
are taken from the current settings in the main window, but you can change
either value using the Change Date and Change Location buttons at the top of
the WUT window.
The WUT tool also displays a short almanac of data for the selected date: the
rise and set times for the Sun and moon, the duration of the night, and the
Moon’s illumination fraction.
Below the almanac is where the object information is displayed. The objects
are organized into type categories. Select an object type in the box labeled
Choose a Category, and all objects of that type which are above the horizon
on the selected night will be displayed in the box labeled Matching Objects.
For example, in the screenshot, the Planets category has been selected, and
four planets which are up on the selected night are displayed (Mars, Neptune,
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Pluto, and Uranus). When an object in the list is selected, its rise, set and transit
times are displayed in the lower-right panel. In addition, you can press the
Object Details... button to open the Object Details window for that object.

By default, the WUT will display objects which are above the horizon between
sunset and midnight (i.e., ‘in the evening’). You can choose to show objects
which are up between midnight and dawn (‘in the morning’), or between dusk
and dawn (‘any time tonight’) using the combobox near the top of the window.

6.6 The Script Builder Tool

KDE applications can be controlled externally from another program, from a
console prompt, or from a shell script using the Inter-process communication
protocol (DCOP). KStars takes advantage of this feature to allow rather com-
plex behaviors to be scripted and played back at any time. This can be used,
for example, to create a classroom demo to illustrate an astronomical concept.

The problem with DBus scripts is, writing them is a bit like programming, and
can seem a daunting task to those who do not have programming experience.
The Script Builder Tool provides a GUI point-and-click interface for construct-
ing KStars DCOP scripts, making it very easy to create complex scripts.

6.6.1 Introduction to the Script Builder

Before explaining how to use the Script Builder, I provide a very brief introduc-
tion to all of the GUI components; for more infomation, use the "What’s This?"
function.
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The Script Builder is shown in the above screenshot. The box on the left is
the Current Script box; it shows the list of commands that comprise the current
working script. The box on the right is the Function Browser; it displays the list
of all available script functions. Below the Function Browser, there is a small
panel which will display short documentation about the script function high-
lighted in the Function Browser. The panel below the Current Script box is the
Function Arguments panel; when a function is highlighted in the Current Script
box, this panel will contain items for specifying values for any arguments that
the highlighted function requires.

Along the top of the window, there is a row of buttons which operate on the
script as a whole. From left to right, they are: New Script, Open Script, Save
Script, Save Script As..., and Test Script. The function of these buttons should
be obvious, except perhaps the last button. Pressing Test Script will attempt to
run the current script in the main KStars window. You should move the Script
Builder window out of the way before pressing this, so you can see the results.

In the center of the window, there is a column of buttons which operate on
individual script functions. From top to bottom, they are: Add Function, Re-
move Function, Copy Function, Move Up, and Move Down. Add Function
adds the currently-highlighted function in the Function Browser to the Cur-
rent Script box (you can also add a function by double-clicking on it). The rest
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of the buttons operate on the function highlighted in the Current Script box,
either removing it, duplicating it, or changing its position in the current script.

6.6.2 Using the Script Builder

In order to illustrate using the Script Builder, we present a small tutorial ex-
ample where we make a script that tracks the Moon while the clock runs at an
accelerated rate.
If we are going to track the Moon, we will need to point the display at it first.
The lookToward function is used to do this. Highlight this function in the Func-
tion Browser, and note the documentation displayed in the panel below the
Browser. Press the Add Function button to add this function to the Current
Script box. The Function Arguments panel will now contain a combobox la-
beled ‘dir’, short for direction. This is the direction in which the display should
be pointed. The combobox contains only the cardinal compass points, not the
Moon or any other objects. You can either enter ‘Moon’ in the box manually, or
press the Object button to use the Find Object window to select the Moon from
the list of named objects. Note that, as usual, centering on an object automat-
ically engages object-tracking mode, so there is no need to add the setTracking
function after lookToward.
Now that we have taken care of pointing at the Moon, we next want to make
time pass at an accelerated rate. Use the setClockScale function for this. Add
it to the script by double-clicking on it in the Function Browser. The Function
Arguments panel contains a timestep spinbox for setting the desired time step
for the simulation clock. Change the timestep to 3 hours.

OK, we have pointed at the Moon and accelerated the clock. Now we just want
the script to wait for several seconds while the display tracks on the Moon.
Add the waitFor function to the script, and use the Function Arguments panel
to specify that it should wait for 20 seconds before continuing.

To finish up, let us reset the clock’s timestep to the normal value of 1 second.
Add another instance of setClockScale, and set its value to 1 sec.

Actually, we are not quite done yet. We should probably make sure that the
display is using Equatorial coordinates before the script tracks the Moon with
an accelerated time step. Otherwise, if the display is using Horizontal coor-
dinates, it will rotate very quickly through large angles as the Moon rises and
sets. This can be very confusing, and is avoided by setting the View Option
UseAltAz to ‘false’. To change any View Option, use the changeViewOption func-
tion. Add this function to the script, and examine the Function Arguments
panel. There is a combobox which contains the list of all options which can be
adjusted by changeViewOption. Since we know we want the UseAltAz option,
we could simply select it from the combobox. However, the list is quite long,
and there is no explanation of what each item is for. It therefore may be easier
to press the Browse Tree button, which will open a window containing a tree
view of the available options, organized by topic. In addition, each item has
a short explanation of what the option does, and the data type of the option’s
value. We find UseAltAz under the Skymap options category. Just highlight
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this item and press OK, and it will be selected in the combobox of the Function
Arguments panel. Finally, make its value ‘false’ or ‘0’.

One more step: changing UseAltAz at the end of the script does us no good;
we need this to be changed before anything else happens. So, make sure this
function is highlighted in the Current Script box, and press the Move Up button
until it is the first function.
Now that we have finished the script, we should save it to disk. Press the Save
Script button. This will first open a window in which you can provide a name
for the script, and fill in your name as the author. Enter ‘Tracking the Moon’
for a name, and your name as the author, and press OK. Next, you will see the
standard KDE Save File dialog. Specify a filename for the script and press OK
to save the script. Note that if your filename does not end with ‘.kstars’, this
suffix will be automatically attached. If you are curious, you can examine the
script file with any text editor.

Now that we have a completed script, we can run it in a couple of ways. From
a console prompt, you can simply execute the script as long as an instance
of KStars is currently running. Alternatively, you can execute the script from
within KStars using the Run Script item in the File menu.
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6.7 Solar System Viewer

This tool displays a model of our solar system as seen from above. The Sun
is drawn as a yellow dot in the center of the plot, and the orbits of the planets
are drawn as ellipses with the correct shapes and orientations. The current
position of each planet along its orbit is drawn as a colored dot, along with
a name label. The display can be zoomed in and out with the + and - keys,
and the display can be recentered with the arrow keys, or by double-clicking
anywhere in the window with the mouse. You can also center on a planet with
the 0–9 keys (0 is the Sun; 9 is Pluto). If you center on a planet, it will be tracked
as time passes in the tool.

The Solar System Viewer has its own clock, independent of the clock in the
main KStars window. There is a timestep control widget here, similar to the
one in the main window’s toolbar. However, this control defaults to a timestep
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of 1 day (so that the motions of the planets can be seen), and it starts out with
the clock paused when the tool is opened.

NOTE
The current model used for Pluto’s orbit is only good for dates within about 100
years of the present date. If you let the Solar System clock advance beyond this
range, you will see Pluto behave very strangely! We are aware of this issue, and
will try to improve Pluto’s orbit model soon.
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6.8 Jupiter Moons Tool
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This tool displays the positions of Jupiter’s four largest moons (Io, Europa,
Ganymede, and Callisto) relative to Jupiter, as a function of time. Time is plot-
ted vertically; the units are days and ‘time=0.0’ corresponds to the current sim-
ulation time. The horizontal axis displays the angular offset from Jupiter’s
position, in arcminutes. The offset is measured along the direction of Jupiter’s
equator. Each moon’s position as a function of time traces a sinusoidal path in
the plot, as the moon orbits around Jupiter. Each track is assigned a different
color to distinguish it from the others; the name labels at the top of the window
indicate the color used by each moon.

The plot can be manipulated with the keyboard. The time axis can be expanded
or compressed using the + and - keys. The time displayed at the center of the
window can be changed with the [ and ] keys.

6.9 Observing List Tool

The purpose of the Observing List Tool is to provide convenient access to some
common functions for a list of objects chosen by you. Objects are added to the
list by using the ‘Add to List’ action in the popup menu, or by simply pressing
the O key to add the currently-selected object.

Objects in the list can be sorted by any of the data columns (Name, Right As-
cension, Declination, Magnitude, and Type). To perform an action on an object,
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highlight it in the list, and then press one of the Action buttons at the top of the
window. Some actions can be performed while multiple objects are selected;
others only operate when one object is selected. The available actions are:

Center Center the display on the selected object, and begin Tracking it.

Scope Point your telescope at the selected object.

Alt vs. Time Open the Altitude vs. Time Tool, with the selected object(s) preloaded

Details Open the Detailed Information Window for the selected object.

Remove Remove the selected object(s) from the observing list.

NOTE
The Observing List tool is a new feature and is still under development. We are
planning to add more features, such as adding objects to the list by selecting a
region in the sky, and the ability to save observing lists to disk.

6.10 FITS Viewer Tool

The Flexible Image Transport System (FITS) is the standard format for repre-
senting images and data in Astronomy.

The KStars FITS Viewer tool is integrated with the INDI framework for seam-
less display and manipulation of captured FITS images. To open a FITS file,
select Open FITS... from the File menu, or press Ctrl+O.

FITS Viewer features:

• Support for 8, 16, 32, IEEE -32, and IEEE -64 bits formats.

• Histogram with linear, logarithmic, and square-root scales.

• Brightness/Contrast controls.

• Pan and Zoom.

• Auto levels.

• Statistics.

• FITS header query.

• Undo/Redo.
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The above diagram illustrates the FITS Viewer work area and window. The
tool provides basic functions for image display. FITS data depth is preserved
throughout all processing, open, and save functions. While the tool adhere to
the FITS standard, it does not support all possible FITS features:

• Support for only one image per file.

• Support for only 2D data. 1D and 3D data are discarded.

• No support for WCS (World Coordinate System).

The following is a brief description of the tool’s functional units:

• Brightness/Contrast: Adjusts brightness and contrast. The function can be
CPU and memory intensive for very large FITS.

• Histogram: Displays one-channel FITS histogram. The user can rescale the
image by optionally defining an upper and lower limit for the cutoff region.
The rescaling operation (linear, logarithmic, or square-root) may then be ap-
plied to the region enclosed by the upper and lower limits.
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• Statistics: Provides simple statistics for minimum and maximum pixel val-
ues and the their respective locations. FITS depth, dimension, mean, and
standard deviation.

• FITS header: Displays FITS header information.
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Chapter 7

Command-Line mode for
Image Generation

You can use KStars to generate an image of the sky without actually launching
the GUI portion of the program. To use this feature, start KStars from a com-
mand prompt using arguments to specify the filename for the image, as well
as the desired image dimensions:
kstars --dump [--filename kstars.png] [--height 640] [--width 480] [--script
myscript.kstars] [--date "4 July 1976 12:30:00"]
If no filename is specified, it generates a file named kstars.png. It will attempt
to generate an image that matches the extension of your filename. The follow-
ing extensions are recognized: ‘png’, ‘jpg’, ‘jpeg’, ‘gif’, ‘pnm’, and ‘bmp’. If the
filename extension is not recognized, it defaults to the PNG image type.
Likewise, if the image width and height are not specified, they default to 640
and 480, respectively.
By default, KStars will read in the options values stored in your $KDEHOME-
/share/config/kstarsrc file to determine where the image will be centered,
and how it is rendered. This means you need to run KStars in normal GUI
mode, and exit the program when it is set up with the desired options for the
generated images. This is not very flexible, so we also provide the ability to
execute a KStars DCOP script to set the scene before generating the image. The
filename you specify as the script argument should be a valid KStars DCOP
script, such as one created with the Script Builder Tool. The script can be used
to set where the image is pointing, set the geographic location, set the time and
date, change the Zoom level, and adjust other view options. Some of the DCOP
functions make no sense in non-GUI mode (such as waitForKey()); if these
functions are encountered while parsing the script, they are simply ignored.
By default, KStars will use the system CPU time and date for generating the
image. Alternatively, you may specify a time and date with the ‘--date’ argu-
ment. You can also use this argument for specifying the startup date in normal
GUI mode.
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Chapter 8

Astronomical Device Control
with INDI

KStars provides an interface to configure and control astronomical instruments
via the INDI protocol.

The INDI protocol supports a variety of astronomical instruments such as CCD
cameras and focusers. Currently, KStars supports the following devices:

Telescope Device driver
LX200 8"-12" Classic indi_lx200classic
Autostar based telescopes indi_lx200autostar
LX200 GPS 8"-16" indi_lx200gps
LX200 Classic 16" indi_lx200_16
NexStar GPS, CGE, AS-GT indi_celestrongps
New GT, NexStar 5i/8i indi_celestrongps
Takahashi Temma indi_temma
Astro-Electronic FS-2 indi_lx200basic
Argo Navis indi_lx200basic
Losmandy Gemini indi_lx200basic
Mel Bartels Controllers indi_lx200basic
Sky Commander indi_skycommander
Intelliscope/SkyWizard indi_intelliscope
Orion Atlas indi_orion_atlas

Table 8.2: Supported Telescopes
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Focuser Device driver
Meade LX200GPS Microfocuser indi_lx200gps
Meade 1206 Primary Mirror
Focuser indi_lx200basic

JMI NGF Series indi_lx200basic
JMI MOTOFOCUS indi_lx200basic
FLI Precision Focuser indi_fli_pdf
RoboFocus indi_robofocus

Table 8.4: Supported Focusers

CCD Device driver
Finger Lakes Instruments CCDs indi_fli_ccd
Santa Barbara Instrument CCDs indi_sbig_ccd
Apogee CCDs indi_apogee_alta

Table 8.6: Supported CCDs

Filter Wheel Device driver
FLI Filter Wheels indi_fli_wheel
True Technology Wheel indi_trutech_wheel

Table 8.8: Supported Filter Wheels

Webcam Device driver
Any Video4Linux compatible
device indi_v4l_generic

Philips webcam indi_v4l_philips
Meade Lunar Planetary Imager indi_meade_lpi
SBIG STV indi_sbig_stv

Table 8.10: Supported Webcams
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8.1 INDI Setup

KStars can control local and remote devices seamlessly via the INDI server/-
client architecture. INDI devices may be run in three different modes:

1. Local: The local mode is the most common and is used to control local
device (i.e. a device attached to your machine).

2. Server: The server mode establishes an INDI server for a particular de-
vice and waits for connections from remote clients. You cannot operate
server devices, you can only start and shut them down.

3. Client: The client mode is used to connect to remote INDI servers run-
ning INDI devices. You can control remote devices seamlessly like local
devices.

You can run local device, establish INDI servers, and connect to remote clients
from the Device Manager in the Devices menu.

Here is a screenshot of the Device Manager window:
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You can run devices by browsing the device tree, selecting a specific device,
and then clicking on the Run Service button. You can select the operation
mode, either local or server as defined above.

To control remove devices, refer to the remote device control section.

8.2 Telescope Setup

Most telescopes are equipped with RS232 interface for remote control. Connect
the RS232 jack in your telescope to your computer’s Serial/USB port. Tradi-
tionally, the RS232 connects to the serial port of your computer, but since many
new laptops abandoned the serial port in favor of USB/FireWire ports, you
might need to obtain a Serial to USB adaptor to use with new laptops.
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After connecting your telescope to the Serial/USB port, turn your telescope on.
It is highly recommended that you download and install the latest firmware for
your telescope controller.

The telescope needs to be aligned before it can be used properly. Align your
telescope (one or two stars alignment) as illustrated in your telescope manual.

KStars needs to verify time and location settings before connecting to the tele-
scope. This insures proper tracking and synchronization between the telescope
and KStars. The following steps will enable you to connect to a device that is
connected to your computer. To connect and control remote devices, please
refer to remote device control section.
You can use the Telescope Setup Wizard and it will verify all the required infor-
mation in the process. It can automatically scan ports for attached telescopes.
You can run the wizard by selecting Telescope Setup Wizard from the Devices
menu.
Alternatively, you can connect to a local telescope by performing the following
steps:

1. Set your geographical location. Open the Geographic... window by se-
lecting Set Geographic Location... from the Settings menu, or by pressing
the Globe icon in the toolbar, or by pressing Ctrl+g.

2. Set your local time and date. You can change to any time or date by
selecting Set Time... from the Time menu, or by pressing the time icon
in the toolbar. The Set Time window uses a standard KDE Date Picker
widget, coupled with three spinboxes for setting the hours, minutes and
seconds. If you ever need to reset the clock back to the current time, just
select Set Time to Now from the Time menu.

3. Click on the Devices menu and select the Device Manager.

4. Under the Device column, select your telescope model.

5. Right-click on the device and select Run Service.

6. Click Ok to close the Device Manager Dialog.

FREQUENT SETTINGS
You do not need to set the geographic location and time every time you connect to
a telescope. Only adjust the settings as needed.

You are now ready to use the device features, KStars conveniently provides
two interchangeable GUI interfaces for controlling telescopes:

CONTROLLING YOUR TELESCOPE

1. Sky map Control: For each device you run in the Device Manager, a corre-
sponding entry will show up in popup menu that allows you to control
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the properties of the device. You can issue commands like Slew, Sync,
and Track directly from the sky map.
Here is a screenshot of the popup menu with an active LX200 Classic
device:

2. INDI Control Panel: The panel offers the user with all the features sup-
ported by a device.
The panel is divided into three main sections:

• Device tabs: Each additional active device occupies a tab in the INDI
panel. Multiple devices can run simultaneously without affecting the
operation of other devices.

• Property view: Properties are the key element in INDI architecture.
Each device defines a set of properties to communicate with the client.
The current position of the telescope is an example of a property. Se-
mantically similar properties are usually contained in logical blocks or
groupings.
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• Log viewers: Devices report their status and acknowledge commands
by sending INDI messages. Each device has its own log view, and all
devices share one generic log viewer. A device usually sends messages
to its device driver only, but a device is permitted to send a generic
message when appropriate.

You are not restricted on using one interface over another as they can be both
used simultaneously. Actions from the Sky map are automatically reflected in
the INDI Control Panel and vice versa.
To connect to your telescope, you can either select Connect from your device
popup menu or alternatively, you can press Connect under your device tab in
the INDI Control Panel.

IMPORTANT
By default, KStars will try to connect to the /dev/ttyS0 port. To change the con-
nection port, select INDI Control Panel from the Devices menu and change the port
under your device tab.

KStars automatically updates the telescope’s longitude, latitude, and time based
on current settings in KStars. You can enable/disable these updates from Con-
figure INDI dialog under the Devices menu.

If KStars communicates successfully with the telescope, it will retrieve the cur-
rent RA and DEC from the telescope and will display a crosshair on the sky
map indicating the telescope position.
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SYNCHRONIZING YOUR TELESCOPE
If you aligned your telescope and the last alignment star was, for example, Vega,
then the crosshair should be centered around Vega. If the crosshair was off target,
then you can right-click Vega from the sky map and select Sync from your telescope
menu. This action will instruct the telescope to synchronize its internal coordinates
to match those of Vega, and the telescope’s crosshair should now be centered
around Vega.

This is it: your telescope is ready to explore the heavens!

WARNING
Never use the telescope to look at the sun. Looking at the sun might cause irre-
versible damage to your eyes and your equipment.

8.3 CCD and Video-Capture Setup

KStars supports the following imaging devices:

• Finger Lakes instruments CCDs

• SBIG CCDs: In order to use SBIG CCDs, you must download and install the
Universal SBIG Driver library from INDI website.

• Apogee CCDs: Only USB versions are supported. You must have libusb
installed.

• Video4Linux compatible devices. Philips webcam extended features are sup-
ported as well.

You can run CCD and Video Capture devices from the Device Manager in the
Devices menu. Like all INDI devices, some of the device controls will be ac-
cessible from the skymap. The device can be controlled fully from the INDI
Control Panel.
The standard format for image capture is FITS. Once an image is captured and
downloaded, it will be automatically displayed in the KStars FITS Viewer. To
capture a sequence of images, use the Capture Image Sequence tool from the
Devices menu. This tool is inactive until you establish a connection to an image
device.

IMPORTANT
The fli and apogee drivers requires root privileges in order to operate properly. Note
that running the driver as root is considered a security risk.
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8.4 Capture Image Sequence

The Capture Image Sequence tool can be used to aquire images from cameras
and CCDs in interactive and batch modes. Furthermore, you can select which
filter, if any, you want to use for your images. The capture tool remains dis-
abled until you establish a connection to an imaging device.

The above screenshot depicts a sample capture session. The tool provides the
following options:

• Camera/CCD

– Device: The desired imaging device.
– Prefix: The image prefix which will be prepended to each captured file-

name.
– Exposure: The number of seconds to expose each frame.
– Count: The number of images to aquire.
– Delay: The delay in seconds between consecutive images.
– ISO 8601 time stamp: Append ISO 8601 time stamp to the filename. (e.g.

image_01_20050427T09:48:05).

• Filter
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– Device: The desired filter device.
– Filter: The desired filter slot. You can assign color values to slot numbers

using the Configure INDI window (e.g. Slot #1 = Red, Slot #2 = Blue..etc).

After you fill in the desired options, you can begin the capture procedure by
pressing the Start button. You may cancel at any time using the Stop button.
All captured images will be saved to the default FITS directory which can be
specified in the Configure INDI window.

If you have more complex capturing requirements and conditions to fulfil, it
is recommended to create a script to meet your specific needs using the Script
Builder tool in the Tools menu.

8.5 Configure INDI

The Configure INDI window allows you to modify Client side INDI specific
options. The window is divided into four main categories: General, Automatic
device updates, Display, and Filter Wheel:

• General

– Default FITS directory: Specify the directory where all captured FITS
images will be saved to. If no directory is specified, images will be stored
in $HOME.

– Automatic Display of FITS upon capture: When checked, KStars will
display captured FITS in KStars FITS Viewer tool. If you use the Capture
Image Sequence tool, all captured images will be saved to disk regardless
of this option.

– Telescope port: The default telescope port. When you connect to a local
or remote telescope service, KStars will automatically fill the telescope’s
device port with the specified default port.

– Video port: The default video port. When you connect to a local or re-
mote video service, KStars will automatically fill the webcam’s device port
with the specified default port.

• Automatic device updates

– Time: Update the telescope’s date and time, if supported, upon connec-
tion.

– Geographic location: Update the telescope’s geographical location in-
formation (current longitude and latitude), if supported, upon connection.

• Display

– Device target crosshair: When checked, KStars displays the telescope’s
target crosshair on the sky map. The crosshair is displayed upon a suc-
cessful connection to the telescope and its location is updated periodically.
The telescope’s name is displayed next to the crosshair. KStars displays
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one crosshair per each connected telescope. To change the color of the
telescope’s crosshair, open the Configure KStars window. Select the Col-
ors tab, and then change the color of the Target Indicator item to the desired
color.

– INDI messages in status bar: When checked, KStars displays INDI sta-
tus messages in the KStars status bar.

• Filter Wheel: Assign color codes to the filter wheel slots (e.g. Slot #0 Red,
Slot #1 Blue..etc). You can assign color codes for up to 10 filter slots (0 to
9). To assign a color code, select a slot number from the drop down combo
box, and then type the corresponding color code in the edit field. Repeat the
process for all desired slots and then press OK.

8.6 INDI Concepts

The main key concept in INDI is that devices have the ability to describe them-
selves. This is accomplished by using XML to describe a generic hierarchy that
can represent both canonical and non-canonical devices. In INDI, all devices
may contain one or more properties. Any property may contain one or more
elements. There are four types of INDI properties:

• Text property.

• Number property.

• Switch property (Represented in GUI by buttons and checkboxes).

• Light property (Represented in GUI by colored LEDs).

For example, all INDI devices share the CONNECTION standard switch prop-
erty. The CONNECTION property has two elements: CONNECT and DIS-
CONNECT switches. KStars parses the generic XML description of properties
and builds a GUI representation suitable for direct human interaction.

The INDI control panel offers many device properties not accessible from the
sky map. The properties offered differ from one device to another. Neverthe-
less, all properties share common features that constrains how they are dis-
played and used:

• Permission: All properties can either be read-only, write-only, or read and
write enabled. An example of a read-write property is the telescope’s Right
Ascension. You can enter a new Right Ascension and the telescope, based
on current settings, will either slew or sync to the new input. Furthermore,
when the telescope slews, its Right Ascension gets updated and sent back to
the client.

• State: Prefixed to each property is a state indicator (round LED). Each prop-
erty has a state and an associated color code:
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State Color Description

Idle Gray
Device is performing
no action with respect
to this property

Ok Green

Last operation
performed on this
property was
successful and active

Busy Yellow The property is
performing an action

Alert Red

The property is in
critical condition and
needs immediate
attention

Table 8.12: INDI State color code

The device driver updates the property state in real-time when necessary.
For example, if the telescope is in the process of slewing to a target, then
the RA/DEC properties will be signaled as Busy. When the slew process is
completed successfully, the properties will be signaled as Ok.

• Context: Numerical properties can accept and process numbers in two for-
mats: decimal and sexagesimal. The sexagesimal format is convenient when
expressing time or equatorial/geographical coordinates. You can use any
format at your convenience. For example, all the following numbers are
equal:

– -156.40
– -156:24:00
– -156:24

• Time: The standard time for all INDI-related communications is Universal
Time UTC specified as YYYY-MM-DDTHH:MM:SS in accord with ISO 8601.
KStars communicates the correct UTC time with device drivers automati-
cally. You can enable/disable automatic time updates from the Configure
INDI dialog under the Devices menu.

8.7 Remote Device Control

KStars provides a simple yet powerful layer for remote device control. A de-
tailed description of the layer is described in the INDI white paper.

You need to configure both the server and client machines for remote control:
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1. Server: To prepare a device for remote control, follow the same steps in
the local/server setup. When you start a device service in the Device
Manager, a port number is displayed under the Listening port column.
In addition to the port number, you also need the hostname or IP address
of your server.

2. Client: Select the Device Manager from the Device menu and click on the
Client tab. You can add, modify, or delete hosts under the Client tab. Add
a host by clicking on the Add button. Enter the hostname/IP address of
the server in the Host field, and enter the port number obtained from the
server machine in step 1.

After you add a host, right click on the host to Connect or Disconnect. If a
connection is established, you can control the telescope from the Sky map or
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INDI Control Panel exactly as described in the local/server section. It is as easy
at that.

8.7.1 Running an INDI server from the command line

While KStars allows you to easily deploy an INDI server; you can launch an
INDI server from the command line.
Since INDI is an independent backend component, you can run an INDI server
on a host without KStars. INDI can be compiled separately to run on remote
hosts. Furthermore, device drivers log messages to stderr and that can be
helpful in a debugging situation. The syntax for INDI server is as following:

$ indiserver [options] [driver ...]

Options:

-l d : log driver messages to d/YYYY-MM-DD.islog

-m m : kill client if gets more than this many MB behind, default 10

-p p : alternate IP port, default 7624

-v : show key events, no traffic

-vv : -v + key message content

-vvv : -vv + complete xml

driver : executable or device@host[:port]

For example, if you want to start an INDI server running an LX200 GPS driver
and listening to connections on port 8000, you would run the following com-
mand:
$ indiserver -p 8000 lx200gps

8.7.2 Secure Remote Operation

Suppose we want to run an indiserver with INDI drivers on a remote host,
remote_host, and connect them to KStars running on the local machine.

From the local machine log onto the remote host, remote_host, by typing:

$ ssh -L local_port:remote_host:remote_port
This binds the local_port on the local machine to the remote_port on the re-
mote_host. After logging in, run indiserver on the remote host:

$ indiserver -p remote_port [driver...]

Back on the local machine, start KStars then open the Device Manager and add
a host under the Client tab. The host should be the local host (usually 127.0.0.1)
and the port number should be the local_port used in the steps above. Right-
click on the host and select Connect from the popup menu. KStars will connect
to the remote INDI server securely. The host information will be saved for
future sessions.

103



The KStars Handbook

8.8 INDI Frequently Asked Questions

Q: What is INDI?

A: INDI is the Instrument-Neutral-Distributed-Interface control protocol de-
veloped by Elwood C. Downey of ClearSky Institute. KStars employs de-
vice drivers that are compatible with the INDI protocol. INDI has many ad-
vantages including loose coupling between hardware devices and software
drivers. Clients that use the device drivers (like KStars) are completely un-
aware of the device capabilities. In run time, KStars communicates with the
device drivers and builds a completely dynamical GUI based on services pro-
vided by the device. Therefore, new device drivers can be written or updated
and KStars can take full advantage of them without any changes on the client
side.
Q: Do you plan to support more devices?

A: Yes. We plan to support major CCD cameras and focusers and extend sup-
port for more telescopes. If you would like INDI to support a particular device,
please send an email to indi-devel@lists.sourceforge.net

Q: What operations does KStars provide to control the telescope?

A: It depends on the particular telescope you’re running, but the minimum
three operations are Slew, Track, and Sync, which you can issue directly from
the sky map. Your telescope must be aligned for those operations to perform
correctly. Some telescopes offer you more operations like site management,
slew modes, focusing, parking, and more. You can access the telescopes ex-
tended features from the INDI Control Panel in the Devices Menu.
Q: What’s the difference between Slew, Track, and Sync exactly?

A: The command Slew orders the telescope to move to a particular target, and
once the telescope reaches its target, the telescope keeps tracking that target at
a sidereal rate (i.e. the rate at which stars move across the sky). This works well
for stars, Messier objects, and about everything outside our solar system. But
solar system objects travel differently across the sky and so the telescope must
Track the objects as they move. Therefore, you need to issue a track command
if you want to track an object with non-sidereal motion. On the other hand,
Sync is used to synchronize the telescope’s internal coordinates with that of an
object you select.

Q: Can I control my telescope remotely?

A: Yes. You can start an INDI server on the machine connected to your tele-
scope and the server will listen to requests from KStars clients. Once you’re
connected, you can control your telescope directly from the sky map. This pro-
cedure is described in detail in the Remote device control section.
Q: When I try to Connect, KStars reports that the telescope is not connected to the
serial/USB port. What can I do?

A: This message is triggered when KStars cannot communicate with the tele-
scope. Here are few things you can do:
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1. Check that you have both reading and writing permission for the port
you are trying to connect to.

2. Check the connection cable, make sure it is in good condition and test it
with other applications.

3. Check your telescope power, make sure the power is on and that the
telescope is getting enough power.

4. Set the correct port in the INDI Control Panel under the Devices menu.
The default device is /dev/ttyS0

5. Restart KStars and retry again.

Q: KStars reports that the telescope is online and ready, but I cannot find the telescope’s
crosshair, where is it?

A: KStars retrieves the telescopes RA and DEC coordinates upon connection.
If your alignment was performed correctly, then you should see the crosshair
around your target in the Sky Map. However, the RA and DEC coordinates
provided by the telescope may be incorrect (even below the horizon) and you
need to Sync your telescope to your current target. You can use the right-click
menu to center and track the telescope crosshair in the sky map.

Q: The telescope is moving erratically or not moving at all. What can I do?

A: This behavior is mostly due to incorrect settings, please verify the following
check list:

1. Is the telescope aligned?

2. Is the telescope alignment mode correct? Use INDI Control Panel to
check and change these settings (Alt/Az,Polar, Land).

3. Are the telescope’s time and date settings correct?

4. Are the telescope’s longitude and latitude settings correct?

5. Is the telescope’s UTC offset correct?

6. Are the telescope’s RA and DEC axis locked firmly?

7. Is the telescope’s N/S switch (when applicable) setup correctly for your
hemisphere?

8. Is the cable between the telescope and computer in good condition?

If you think all settings are correct but the telescope still moves erratically or
not at all, then please send a report to indi-devel@lists.sourceforge.net
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Chapter 9

Questions and Answers

This document may have been updated since your installation. You can find
the latest version at http://docs.kde.org/development/en/kdeedu/ .

1. What is the KStars Icon?
The KStars Icon is a sextant, a handheld telescope which was used by
navigators on sailing ships back when the stars were important for nav-
igation. By carefully reckoning the positions of the stars, the navigator
could get an accurate estimate of the ship’s current longitude and lati-
tude.

2. What do the different symbols for deep-sky objects mean?
The symbol indicates the object type:

• dotted circle: Open Cluster
• cross-in-circle: Globular Cluster
• box: Gaseous Nebula
• diamond: Supernova Remnant
• circle with outer lines: Planetary Nebula
• ellipse: Galaxy

3. What do the different colors of Deep-sky objects mean?
Generally, the different colors indicate to which catalog the object belongs
(Messier, NGC or IC). However, some objects have a different color which
indicates that there are extra images available in the popup menu (the
default ‘extras’ color is red).

4. Why are there so many more U.S. cities than in other countries?
When we started KStars, we were unable to find a longitude/latitude
database that covered the globe equitably. However, the KStars commu-
nity is rapidly overcoming this problem! We have already received city
lists from many users around the world. If you can contribute to this
effort, please send us your list of cities and coordinates.
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5. I have added a custom location to KStars that I no longer want. How do I remove
it from the program?
You will have to edit the /.kde/share/apps/kstars/mycities.dat file,
and remove the location’s line from that file.

6. Why can I not display the ground when using Equatorial Coordinates?
The short answer is, this is a temporary limitation. There is a problem
when constructing the filled polygon that represents the ground when in
Equatorial mode. However, it does not make too much sense to draw the
ground in equatorial coordinates, which is why this fix has been given a
low priority.

7. Why do some objects disappear when I am scrolling the display?
When the display is in motion, KStars must recompute the screen coor-
dinates of every object in its database, which involves some pretty heavy
trigonometry. When scrolling the display (either with the arrow keys or
by dragging with the mouse), the display may become slow and jerky, be-
cause the computer is having trouble keeping up. By excluding many of
the objects, the computational load is greatly reduced, which allows for
smoother scrolling. You can turn off this feature in the Configure KStars
window, and you can also configure which objects get hidden.

8. I do not understand all the terms used in KStars. Where can I learn more about
the astronomy behind the program?
The KStars Handbook includes the AstroInfo Project; a series of short,
hyperlinked articles about astronomical topics that can be explored and
illustrated with KStars. AstroInfo is a community effort, like GNUpedia
or Everything2. If you’d like to contribute to AstroInfo, please join our
mailing list: kstars-info@lists.sourceforge.net.

9. I want KStars to start up with a time and date different from my system CPU
clock. Is this possible?
Yes; to start kstars with a different time/date, use the ‘--date’ argument,
followed by a date string like ‘4 July 1976 12:30:00’

10. I want KStars to start up with the simulation clock paused. Is this possible?
Yes; to start kstars with the clock paused, simply add the ‘--paused’ ar-
gument to the command line.

11. How accurate/precise is KStars?
KStars is pretty accurate, but it is not (yet) as precise as it can possibly
be. The problem with high-precision calculations is that you start having
to deal with a large number of complicating factors. If you are not a
professional astronomer, you will probably never have a problem with
its accuracy or precision. Here is a list of some of the complicating factors
which limit the program’s precision:

• Planet positions are only accurate for dates within 4000 years or so of
the current epoch. The planet positions are predicted using a Fourier-
like analysis of their orbits, as observed over the past few centuries. We
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learnt in school that planets follow simple elliptical orbits around the
Sun, but this is not strictly true. It would be true only if there was only
one planet in the Solar system, and if the Sun and the planet were both
point masses. As it is, the planets are constantly tugging on each other,
perturbing the orbits slightly, and tidal effects also induce precessional
wobbling. In fact, recent analysis suggests that the planets’ orbits may
not even be stable in the long term (i.e., millions or billions of years). As
a rule of thumb, you can expect the position of a planet to be accurate
to a few arcseconds between the dates -2000 and 6000.
Pluto is the exception to this; its position is perhaps ten times less pre-
cise than the positions of the other planets. Still, for dates near the
present epoch, its position can be trusted to about an arcsecond.
The moon’s position is the most difficult to predict to high precision.
This is because its motion is quite perturbed by the Earth. Also, since
it is so nearby, even minute effects that would be undetectable in more
distant bodies are easily apparent in the moon.
The objects with the worst long-term precision in the program are the
comets and asteroids. We use a very simplistic orbital model for the mi-
nor planets that does not include third-body perturbations. Therefore,
their positions can only be trusted for dates near the present epoch.
Even for the present epoch, one can expect positional errors among the
minor planets of order 10 arcseconds or more.

12. Why do I have to download an improved NGC/IC catalog and Messier object
images? Why not just include them as part of the KStars distribution?
The author of the downloadable NGC/IC catalog has released it with the
restriction that it may not be used commercially. For most KStars users,
this is not a problem. However, it is technically against the KStars license
(the GPL) to restrict usage in this way. We removed the Messier object
images from the standard distribution for two reasons: to simply reduce
the size of KStars, and also because of similar licensing concerns with
a couple of the images. The inline images are significantly compressed
to a very low quality from their original form, so I doubt there is a real
copyright concern, but I did obtain explicit permission from the images’
authors to use the few images for which there was any question about it
(see README.images). Still, just to be absolutely safe, I removed them from
the standard distribution, and marked the download archive as being
"free for non-commercial use".

13. I am really enjoying the beautiful images I have downloaded through KStars! I
would like to share them with the world; can I publish a calendar featuring these
images (or are there any usage restrictions on the images)?
It depends on the image, but many of the images restrict against com-
mercial usage. The Image Viewer’s statusbar will usually contain infor-
mation about the image’s copyright holder, and what usage restrictions
apply. As a rule of thumb: anything published by NASA is in the public
domain (including all HST images). For everything else, you can pretty
safely assume that the images may not be used commercially without
permission. When in doubt, contact the image’s copyright holder di-
rectly.
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14. Can I help contribute to future versions of KStars?
Yes, definitely! Introduce yourself on our mailing list: kstars-devel@kde.org.
If you want to help with the coding, download the latest CVS version of
the code and dive right in. There are several README files in the distri-
bution that explain some of the code’s subsystems. If you need ideas of
what to work on, see the TODO file. You can submit patches to kstars-
devel, and feel free to post any questions you have about the code there
as well. If you are not into coding, we can still use your help with i18n,
docs, AstroInfo articles, URL links, bug reports, and feature requests.
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Chapter 10

Credits and License

KStars
Program copyright 2001-2003 The KStars Team kstars@30doradus.org

The KStars Team:

• Jason Harris kstars@30doradus.org

• Jasem Mutlaq mutlaqja@ku.edu

• Pablo de Vicente pvicentea@wanadoo.es

• Heiko Evermann heiko@evermann.de

• Thomas Kabelmann tk78@gmx.de

• Mark Hollomon mhh@mindspring.com

• Carsten Niehaus cniehaus@gmx.de

Data Sources:

• Object catalogs and planet position tables: NASA Astronomical Data Center

• Detailed credit information for all of the images used in the program is pre-
sented in the file README.images

References:

• ‘Practical Astronomy With Your Calculator’ by Peter Duffet-Smith

• ‘Astronomical Algorithms’ by Jean Meeus

110

mailto:kstars@30doradus.org
mailto:kstars@30doradus.org
mailto:mutlaqja@ku.edu
mailto:pvicentea@wanadoo.es
mailto:heiko@evermann.de
mailto:tk78@gmx.de
mailto:mhh@mindspring.com
mailto:cniehaus@gmx.de
http://adc.gsfc.nasa.gov


The KStars Handbook

Special thanks: To the KDE and QtTM developers for providing the world with
a peerless set of free API libraries. To the KDevelop team, for their excellent
IDE, which made developing KStars so much easier and more fun. To everyone
on the KDevelop message board, the KDE mailing lists, and on irc.kde.org, for
answering our frequent questions. Thank you to Anne-Marie Mahfouf, for
inviting KStars to join the KDE-Edu module. Finally, thanks to everyone who
has submitted bug reports and other feedback. Thank you, everyone.

Documentation copyright 2001-2003 Jason Harris and the KStars Team kstars@30doradus.org

This documentation is licensed under the terms of the GNU Free Documenta-
tion License.
This program is licensed under the terms of the GNU General Public License.
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Appendix A

Installation

A.1 How to obtain KStars

KStars is distributed with KDE as part of the kdeedu "Edutainment" module.

We also occasionally make an independent release. These independent re-
leases will be available as a gzipped tar archive from the following website:
http://prdownloads.sourceforge.net/kstars/ .

Independent releases are announced through the kstars-announce@lists.sourceforge.net
mailing list. Releases are also posted to the KStars home page, kde-apps.org,
and freshmeat.net.
KStars is been packaged by many Linux/BSD distributions, including Redhat,
Suse, and Mandrake. Some distributions package KStars as a separate applica-
tion, some just provide a kdeedu package, which includes KStars.

If you would like the latest SVN development version of KStars, please follow
these instructions.

A.2 Requirements

In order to successfully run KStars, you need KDE >=4.0 and QtTM>=4.3.

To compile KStars, you will also have to have the following packages installed:

• kdelibs-devel

• qt-devel

• zlib-devel

• fam-devel
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• png-devel

• jpeg-devel

• cmake

On my system, KStars uses about 60 MB of system memory with the default
settings. Most of this usage is due to the loaded object databases. You can
dramatically reduce the memory footprint by reducing the faint limit for stars
in the Configuration Window, or eliminating catalogs of objects (NGC, IC,
comets, asteroids, etc.). If KStars is idling, it uses very little CPU; but it will
use as much as you have got when panning or zooming.

A.3 Compilation and Installation

In order to compile and install KStars on your system, type the following in the
base folder of the unpacked KStars distribution:

% ./configure --prefix=$KDEDIR
% make
% make install

Please do not forget the prefix argument to configure. If your KDEDIR variable
is not set, set prefix to whatever folder KDE is installed in: this is usually either
/usr, /opt/kde, or /opt/kde3. Also, make sure you do the last step as root.

KStars uses autoconf and automake, so you should not have trouble compiling
it. Should you run into problems please report them to the KStars mailing list
kstars-devel@kde.org.

A.4 Configuration

At this point, there are no special configuration options or requirements. If
KStars complains that there are missing data files, become root and manually
copy all files in kstars/data/ to $(KDEDIR)/apps/kstars/ (If you do not have
root privileges, copy them to /.kde/share/apps/kstars/.)
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Appendix B

Index

A
Altitude, see Horizontal Coordinates
Animated Slewing, 14
Astronomical Unit, see Parallax
Atmospheric Refraction, 14
Azimuth, see Horizontal Coordinates

B
Blackbody Radiation, see Star Col-

ors and Temperatures

C
Capture

Image, 98
CCD Video Control

Setup, 97
Celestial Coordinate Systems

Ecliptic Coordinates, see Eclip-
tic

Equatorial Coordinates, see Ce-
lestial Equator

Galactic Coordinates, 29
Horizontal Coordinates, see Hori-

zon
Overview, 27

Celestial Equator, see Equatorial Co-
ordinates

Celestial Poles, see Equatorial Coor-
dinates

Celestial Sphere, see Celestial Coor-
dinate Systems

Color Schemes
Customizing, 14
Selecting, 15

Commands
Keyboard, 22
Menu, 18

Keyboard Shortcuts, 23
Mouse, 24

Configure
INDI, 99

Configure KStars window, 13
Advanced Tab, 14
Catalogs Tab, 13
Colors Tab, 14
Guides Tab, 14
Solar System Tab, 14

D
Dark Matter, 41
Date and Time

Extended range of dates, 13
Setting, 12
The simulation clock, 12

Declination, see Equatorial Coordi-
nates

E
Ecliptic, see Ecliptic Coordinates
Elliptical Galaxies, 47
Equinoxes, see Celestial Equator

F
Field-of-View Symbols

Customizing, 15
Defining New, 17
Description, 15

Find Object Tool, 7
Flux, see Luminosity

G
Geographic Coordinate System, 32
Geographic Location Tool

Custom locations, 12
Filtering, 12

Great Circles, see Celestial Sphere

H
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Horizon, see Horizontal Coordinates
Hour Angle, see Local Meridian

I
Image-dump Mode, 89
INDI

Setup, 92, 93
INDI Control

Overview, 90
Info Boxes

Customizing, 15
Shading, 15

J
Julian Day, 35

L
Latitude, see Geographic Coordinate

System
Leap Years, 35
Local Meridian, see Hour Angle
Longitude, see Geographic Coordi-

nate System
Luminosity, see Flux

M
Magnitude Scale, see Flux
Main sequence, 51
Milky Way, 29

N
Navigation Controls

Basics, 4
Keyboard, 22
Mouse, 24

O
Objects in the Sky

Centering, 24
Details, 56
Finding by Name, 7
Hiding, 15
Identifying, 24
Internet Links, see Popup Menu

Customizing, 56
Invoking Popup Menu for, 24
Keyboard Actions, 9, 23
Labeling

Automatic, 15
Overview, 5
Tracking, 9

Orbit Trails
Attached to centered object, 9

P
Parallax, 45
Parsec, see Parallax
Popup Menu

Description, 21
Example, 5

Precession, 34

R
Retrograde Motion, 46
Right Ascension, see Equatorial Co-

ordinates

S
Setup Wizard, 4
Sidereal Time, see Hour Angle
Spiral Galaxies, 48
Star Colors and Temperatures, see

Blackbody Radiation
Stars, 51

T
Telescope Control

Concepts, 100
FAQ, 104
Remote Devices, 101

Time Zones, 38
Toolbars

Customizing, 15
Tools, 55

AAVSO Lightcurve Generator,
71

Altitude vs. Time Tool, 74
Astrocalculator, 57

Angular Distance module, 59
Apparent Coordinates mod-

ule, 60
Day Duration module, 67
Ecliptic Coordinates module,

61
Equatorial/Galactic Coordi-

nates module, 62
Equinoxes and Solstices mod-

ule, 68
Geodetic Coordinates mod-

ule, 65
Horizontal Coordinates mod-

ule, 63
Julian Day module, 69
Planet Coordinates module,

66
Precession module, 64
Sidereal Time module, 70

FITS Viewer, 86
Jupiter Moons Tool, 84
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Object Details Window, 56
Observing List Tool, 85
Script Builder, 77
Solar System Viewer, 81
What’s Up Tonight? Tool, 76

U
Universal Time, see Time Zones

Z
Zenith, see Horizontal Coordinates
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